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Introduction 
Web Human Resources (WebHR) is a Class 3 (C3) automated human resources system that creates an 
electronic request for personnel actions, Standard Form 52 (SF-52) and tracks the document through the 
process. WebHR contains the elements necessary to process an SF-52 within a personnel office. This 
includes initiating, tracking, showing results, and finalizing a personnel action.  
 
WebHR is a web-based, integrated module that brings workforce components together for Human 
Resources (HR) staff and managers to conduct online HR business activities. The application is designed 
with two interfaces: Customer Edition and Automated Human Resources Edition. The application also 
contains several reports, which assist both managers and HR staff with managing employees and 
recruitment activities. 
 
There are two WebHR links on the WebHR SharePoint: http://vaww.htm.wmc.va.gov/HRIS/default.aspx  

• WebHR Customer Edition for customers (service lines) to electronically submit an SF-52 to Human 
Resources.  

• WebHR Automated Human Resources (HR) Edition for the HR staff to process an electronically 
submitted SF-52; and includes a Staffing Module that enables HR staff to enter and track hiring 
milestones and metrics. 

 
WebHR receives data from the national Personnel and Accounting Integrated Data (PAID)/Veterans 
Health Information System Technology Architecture (VistA) system. WebHR is linked to the PAID 
database, which is a data warehouse for all VA personnel employee information. PAID is updated at the 
close of each pay period. The update allows employee-data to auto-populate an SF-52 when a form is 
initiated. The WebHR application, in its association with PAID data, allows for review of employee 
information.  
 
Because WebHR operates in an integrated, secure, web-based environment, access and processes follow 
conventions dictated by an integrated, secure, web-based environment. Users interact with WebHR 
through Internet Explorer (IE) toolbars and menus.  

Note: The WebHR application contains sensitive information and you must employ 
safeguards to ensure the security of the data contained within. Access to WebHR is 
granted through a formal request process. 

WebHR is in production at all Veterans Health Administration (VHA) sites and at several VHA Program 
Offices. The Healthcare Talent Management (HTM) Office handles WebHR enhancements, training, and 
support. 

Note: For assistance with issues/concerns about the Web HR application, contact the 
local WebHR Administrator. 

http://vaww.htm.wmc.va.gov/HRIS/default.aspx�
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Documentation 
WebHR is compatible with Microsoft (MS) Office products and uses features like copy, paste, etc.   
The Microsoft Office link: http://office.microsoft.com/en-us/help/default.aspx provides training, demos, 
and guides, as well as provides assistance with the variety of Microsoft versions used at individual sites. 
 
There are three user manuals associated with the two editions of WebHR. The WebHR user manuals are 
available in MS Word (.docx) format and the Portable Document Format (.pdf) on the VA Software 
Documentation Library 
http://www4.va.gov/vdl/  

1. WebHR Human Resources specialists use the WebHR User Manual for the Automated Human 
Resources Edition 

2. Local WebHR Administrators use the WebHR User Manual for the Administrator Role 

3. WebHR customers (approvers/requesters/delegates) use the WebHR User Manual for the Customer 
Edition 

 
 
 
 

http://office.microsoft.com/en-us/help/default.aspx�
http://www4.va.gov/vdl/�
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Human Resources Role in WebHR 
The WebHR Human Resources specialist is an individual working in HR at a facility/program office. All 
HR staff members are assigned the Staff_HR Agent type by the HTM office and are assigned the 
Specialist role by the WebHR Administrator. 

Access to the WebHR Human Resources Edition 
Access to the application is allowed only after appropriate authorization paperwork is forwarded to the 
local WebHR Administrator who will assign user roles. The WebHR Administrator is responsible for 
granting access to the local users, HR staff, and customers. 
• An additional user name and password is not required; WebHR automatically does a multi-step 

authentication of the user.  
• For issues accessing the application, contact your local WebHR Administrator for assistance.  

Note:  A Find My Administrator list is on the WebHR SharePoint under Shared 
Documents. 
http://vaww.htm.wmc.va.gov/HRIS/Shared%20Documents/Forms/AllItems.aspx 

Responsibilities of the HR Role 
The specialist role manages Human Resources (HR) procedures for processing an SF-52. 
The Human Resources specialist creates, processes, routes, views, and completes SF-52s, as well as 
handling requests for personnel actions, such as promotions, recruitments, and retirements. 
The HR specialist also logs and tracks recruitment actions as the personnel actions move through the 
staffing process. 

Recommendation from WebHR 
For consistency, create all actions in WebHR Customer Edition, even those for HR Staff members. Any 
action created in the HR Edition, is only visible in the HR edition. 

• A service line (other than an HR service line) cannot view or access actions created in WebHR 
Automated Human Resources Edition for the service line.  

• HR can initiate actions for employees assigned to HR. However, if HR initiates an action for any 
other employee, that action is not visible to the service line or the requesting/approving official.  

 

 

 
 
 
 

http://vaww.htm.wmc.va.gov/HRIS/Shared%20Documents/Forms/AllItems.aspx�
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WebHR Automated Human Resources Edition 

1. Open http://vaww.htm.wmc.va.gov/HRIS/default.aspx and select the WebHR –Human Resources–
Live Account link. 
The I Acknowledge Warning page displays. 

 

WebHR Automated HR Edition Warning page 

Warning message 

This US Government computer system contains sensitive information and is for official 
use only. Activity on this system is monitored. Use of this system constitutes your 
unconditional consent to such monitoring and no expectation of privacy. Misuse of, 
unauthorized access to, or attempted unauthorized access to this system will result in 
administrative disciplinary action and/or criminal prosecution as appropriate. 

 

2. Click the I Acknowledge button. 
WebHR Home page displays with user profile. 

 

WebHR Automated Human Resources Edition Home page with User  and Organizational profiles 

http://vaww.htm.wmc.va.gov/HRIS/default.aspx�
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User Profile 

The user profile information comes directly from Outlook; the database is the Active Directory.  

• If the title and phone number are correct in Outlook, but not in WebHR, contact the local WebHR 
Administrator.  

• If the information is incorrect in Outlook, contact the local IT staff to make corrections. After 
corrections are made, contact the local WebHR Administrator to update the user account. 

Organizational Profile 

The organizational profile information lists the highest organization level to which the user has access. 
Access for subordinate units is automatic.  

• Duty Code is only applicable to facilities with consolidated HR offices. 

• Duty Code Flag is only applicable to facilities with consolidated HR offices. 

Information Alerts 

The Information Alerts are reminders, internal to the application, which display when WebHR is opened. 
The alert information displays when the alert recipient logs on to WebHR. The HR staff member also 
receives an Outlook email indicating an action was routed to them. 

 

Infor mation Aler ts 

To delete an alert from the list, click the X in a red circle icon  next to the alert. 

Note: If you intend to act on the action later, you may want to leave the alert as a 
reminder to work on the action. 

About Alerts 

• WebHR does not automatically send an Outlook email alert; but you can send an internal application 
alert. The next time the requester/approver logs into WebHR, the alert displays on the Profile page. 

• In order to receive a WebHR alert, the requester’s/approver’s name must be in the list of names under 
Alerts>Send. No WebHR alerts can be sent to individuals not on the list. Contact your WebHR 
Administrator to add requesters and authorizers. 

• When the names of a requester/approver are manually entered, an alert may not automatically be sent. 
The requester/approver can review the SF-52 using Requests>View after external notification, where 
they can find the action by number or employee name. 



 

6 WebHR C3-C1 Conversion Project October 2011 
 User Manual for the Automated HR Edition (WEBH*) 

Bulletin Board 

The bulletin board contains informational items that are pertinent to the user, such as updates, changes, 
and information applicable to the system.   
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WebHR Automated HR Edition Menus 

Home Menu 
The Home menu is a list of links to external HR resources available within WebHR.  

 

WebHR/HR Edition>Home 

Acronym Description 
OHRM Office of Human Resources Management 
HRIS Human Resources Information Service 
EOPF Office of Personnel Management 
E-Class Monster Government Solutions 
HR Library Office of Human Resources Management/HR Library  
OPM U.S. Office of Personnel Management 
WMCO VHA Workforce Management and Consulting Office 
HTM VHA Healthcare Talent Management National Program Office 
HRRC Human Resources Resource Center 
USA Staffing OPM’s USA Staffing System 
Vet Pro VA's web-based credentialing system for all VHA licensed health care personnel 
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Reports Menu 
The Reports menu provides four report options: PAID (Personnel and Accounting Integrated Data) 
Reports, ARPA (Automated Request for Personnel Actions) Reports, Staffing Reports, and Exception 
Reports, and an option for the HR Dashboard. These reports are canned reports, using employee PAID 
data, which is updated on a regular basis. 

 

Repor ts menu 

These reports are available in three formats.  

•  The Flat file icon allows you to download and have access to .pdf-like features. 

•  The Excel file icon allows you to download and have access to Excel features.   

•  The MS Word file icon allows you to download and have access to MS Word features. 

PAID Reports Option 

1. Open the Reports menu. 

2. Click the PAID Reports option. 
The Reports-PAID page displays. 

3. Select a report format. 
The selected report displays. 

4. Click X in the upper right corner of the browser, to return to WebHR after reviewing the report. 
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Repor ts – PAID 

Dentist Pay 

The Dentist Pay report provides information to allow the comparison of employees in the same 
occupation, as well as to deal with pay-setting processes.  

WebHR Active Employees List 

The WebHR Active Employees List is a list of all employees (including temporary, fee basis, 
trainees/interns, and residents) at the station(s)/VISN or organization/service/department.  

• The WebHR Active Employees List is updated throughout the week.  

• A complete PAID match with the data is done two days after the end of each pay period. 

Negative Leave Balance 

The Negative Leave Balance Report lists employees who have a negative sick-leave balance and/or 
annual-leave balance.  

Physician Pay 

The Physician Pay report provides information to allow the comparison of employees in the same 
occupation, as well as to deal with pay-setting processes. 

Retirement Eligibility 

The Retirement Eligibility Report lists employees, who may potentially be eligible for retirement based 
on age (55 and older).  

• The Service Computation date in this report includes all federal/military service, regardless of 
deposits made or not made for prior service. 

• The Retirement Eligibility report does not indicate who is retiring, only who has reached the age of 
55 and may meet the eligibility criteria to retire. 
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ARPA Reports Option 

 

Repor ts - ARPA 

There are two ARPA (Automated Request for Personnel Actions) reports. These reports provide the total 
number of requests nationally entered into the WebHR application in a fiscal year on a monthly basis and 
a quarterly basis. Each report opens in a separate page and displays in two formats: table and graph.  

1. Open the Reports menu. 

2. Click the ARPA Reports option. 
The Reports-ARPA page displays. 

3. Select a report format. 
The selected report displays. 

4. Click X in the upper right corner of the browser, to return to WebHR after reviewing the report. 

Monthly Totals 

The Monthly Totals report is a table/graph displaying the total number of SF-52s nationally entered into 
the WebHR application in a fiscal year on a monthly basis. 

Quarterly Totals 

The Quarterly Totals report is a table/graph displaying the total number of SF-52s nationally entered into 
the WebHR application in a fiscal year on a quarterly basis.   
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Staffing Reports Option 

Refer to Staffing Reports on page 45. 

 

(Staffing) Repor ts – HR Measurements 

Exception Reports Option 

There are five reports available. These reports provide data from the PAID system. 

 

Repor ts Exception 

1. Open the Reports menu. 

2. Click the Exception Reports option. 
The Reports-Exception page displays. 

3. Select a report format. 
The selected report displays. 

4. Click X in the upper right corner of the browser, to return to WebHR after reviewing the report. 
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45 Day Follow-Up Codes 

The 45 Day Follow-Up Codes report displays follow-up codes in a single list and is sorted by the follow-
up code. Licensure expiration (L*) and Physician Market Pay review (MP) follow-ups are excluded from 
this report.  

Note: When you download this report as an Excel file, each follow-up code displays on a 
separate tab at the bottom of the Excel worksheet. 

This report is color coded for expired, current and upcoming dates.  

• Red = follow-up date is passed (expired) 

• Yellow = follow-up date is current 

• Green = follow-up date is within 45 days (upcoming) 

Annual Leave Balance 

The Annual Leave Balance report displays accrued leave as of the identified pay period. This report can 
help determine the use or loss of leave.  
This report is color coded for greater than or equal and balances within percentage. 

• Red = leave balances greater than or equal to 240 (or 685) hours  

• Yellow = leave balances within 80% of 240 (or 685) hours 

Market Pay Review 

The Market Pay Review report lists the reviews of physicians and dentists market pay in relation to the 
review date. This review is required no less than once every 24 months. The report displays the review 
date for physicians and dentists market pay within 6 months of the 2-year end date. 

Position Data Validation Report 

The Position Data Validation report displays data related to the position and the encumbered position as 
found in PAID. This report compares PD numbers/functional statements with identical PD numbers and 
identifies anomalies in the data fields.  

• Highlighted fields indicate differences that may need to be resolved or may be appropriate.  

• You must review the information to determine if corrections are necessary. 

Uniform Allowance 

The Uniform Allowance report identifies employees who receive uniform allowance payments by pay 
period; it does not include the initial lump sum uniform allowance.  

• This report does not identify employees who are entitled to a uniform allowance payment; entitlement 
is governed by local determinations and negotiated agreements/supplements. 

• When an employee is listed, who is in a position typically not authorized to receive an allowance, you 
should investigate whether or not this is an error. 
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HR Dashboard Option 

The HR Dashboard option redirects you to the VHA Support Service Center (VSSC) Human Resources 
Dashboard, where you can access: 

• HR Dashboard 

• VSSC Help Desk/Homepage Links 

• Training Calendar 

• Other Related Reports  

VHA Support Service Center (VSSC) 

1. Open the Reports menu. 

2. Click the HR Dashboard option. 
The Human Resource Dashboard page displays. 

 

Repor ts>HR Dashboard 

3. Click X in the upper right corner of the browser, to return to WebHR after reviewing the report. 

4. Select the Data Definitions/Important Links menu. 
Data Definitions/Important Links menu displays. 

 

Data Definitions/Impor tant Links page 
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5. Click the VSSC Help Desk/Homepage Links option to access the VSSC Homepage and the Help 
Desk. 

 

Data Definitions/Impor tant Links 

6. Click the VSSC Homepage option to open the VHA Support Service Center Data Use Agreement.  
VHA Support Service Center website opens. 

 

VSSC Homepage 

Note: Because the HR Dashboard is outside of WebHR, direct your questions to the 
VSSC Help Desk. 

7. Click the Help Desk option for assistance with the HR Dashboard.  
VSSC Help Desk sign up form displays. 

 

VSSC Help Desk Sign Up form 
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Positions Menu 
The Positions menu provides the View option. 

 

Positions menu 

Note: The Positions menu is not a position management module. The VHALWD system 
provides this data and therefore more data positions display than are actually 
assigned to the organization.  

View Option 

Use the View option to review the positions, including classification and appropriation break down 
information, for your organization by Position Title, Series, or Appropriation Code. 

1. Open the Positions menu. 

2. Click the View option. 
The Positions page displays. 

 

Positions page with IT Specialists listed 
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Note: On the Positions page, the columns can be sorted and additional pages of records 
can be accessed. For more information, refer to page 137. 

3. Click the Show All button to view all positions for an organization in WebHR.  

4. To view a particular Position Title, Series, or Appropriation Code: 

a. Type the name into the appropriate text box.  

b. Click the binoculars icon . 

Note: Click the magnifying glass icon to view the position details or click the 
green/yellow icon to create a request for action. 

5. Click the magnifying glass icon  to view the position details.  
The Position Details page displays. 

Position Details 

Notes: Some of the information for the position is auto populated. Verify the 
information, rather than create the SF-52 from scratch.  
A recruitment SF-52 can be initiated on an encumbered position. 

 

Positions-Position Details page 

Note: If the position is vacant and ready to recruit, click the green/yellow icon  at the 
top of the Positions Details page on the right side; otherwise, click the 
green/yellow icon  at the top of the Positions page in the second column on the 
left side.  



 

October 2011 WebHR C3-C1 Conversion Project 17 
 User Manual for the Automated HR Edition (WEBH*) 

Position section 

The Position section contains all the details related to the position. 

Organization section 

The Organization section contains classification information for the position, as well as the appropriation 
break down information.  

Vice section 

• If the position is encumbered, the name of the person occupying that position displays with the date 
the position was started. 

• If the position is vacant, the VICE name displays with the date the position started and ended.  

• If the position is new, Vacant displays with No Data Returned. 

Note: Vice information is pulled from the VHALWD database; the name from the 
encumbered position or Position Vacant may display. 

Workflow section 

The Workflow section captures data for classification requests for the selected position. The HR office 
can enter who is assigned the request, when the request is received, and when the classification is 
finished, as well as the documented final action completed. 

Remarks section 

The Remarks section captures any comments about the position. 
 

New Request Form (Gain) 

1. Click the green/yellow icon  to create a request for action. 
The Requests-New Request Form (Gain) page displays. 

Note: The request submission pages that display vary depending on the type of action 
you initiate. 
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Requests-New Request Form (Gain) page 

 

2. Review the Requests-New Request Form (Gain) page.  
Verify the information. 

Request Type 

3. Pro Effective Date is a required field.  
Manually enter a date or select a date from a pop-up calendar. 

• For today’s date, click Today at the bottom of the calendar. 

• Click the date box and select a date from the calendar. 

• Type in a date with the format: mm/dd/yyyy.  

 

Pop-up Calendar  
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Action Requested By and Action Authorized By 

4. Optional: Update/change the name(s) in the Action Requested By and Action Authorized By sections. 
Action Requested By and Action Authorized By are auto-populated, only in the HR Edition, with 
the name of the station HRO.  

• If this information is changed to a person outside of HR, the action is not visible. 

• Once the action is submitted, the Requested By and Authorized By fields cannot be edited. 

For Additional Information Call 

5. Change/update the contact information, if necessary. 
The Contact information defaults to the user who is logged on and initiating the SF-52; however, the 
user can change this information. 

Part B To and Part B Position Data 

6. Ensure the correct site is selected in Part B Position Data. 
The Part B To and Part B Position Data sections are auto-populated.  

 
Field Description 
Part B To 
Refers to the requested action 
Title Position title 
Number Required 

Same as Position Description (PD) Number 
Pay Plan Pay plan identifies the pay system under which the 

employee’s compensation is determined 
Step Step grade for the position; if unknown, can be left blank 
Local Adj Local pay adjustment is the pay amounts established as 

supplemental pay, based on higher cost of living assessments 
in some geographical areas; if unknown, can be left blank 

Comp Level Competitive level identifies positions in a competitive area 
that are in the same grade or occupational level; if unknown, 
can be left blank 

Grade Grade is the specific identifier that indicates pay level within 
a pay plan system; if unknown, can be left blank 

Salary Base salary for position 
Adj Basic Pay Adjusted basic pay; if unknown, can be left blank 
Pay Basis Pay basis identifies the principal condition that serves as a 

basis for computing pay; if unknown, can be left blank 
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Field Description 
Series Occupational series code identifies the subdivision of an 

occupational family or group, under which an employee's 
position is classified 

Basic Pay Basic pay is the amount in the general pay tables for the 
grades; if unknown, can be left blank  

Other Pay Other pay depends on the position; if unknown, can be left 
blank 

Part B Position Data 
Refers to the Position 
Site Duty Station 

Use the Site drop-down list to ensure the correct site is 
selected; change if necessary. 

ApprCode Appropriation code is a combination of a 4-digit 
organizational code and a 4-digit cost center code 
Add or change, if necessary 

OrgCode Organizational code is a 4-digit numerical code that 
identifies a service line 

CCCode Cost Center Code 
Work Schedule  (FT or PT) 

• Select Full-time, Part-time, or Intermittent 
• Required: enter hours scheduled per pay period 

Org Title Name of the organization 
CC Title Name of the cost center 
Vice VICE is the name of a previous employee for a vacant 

position 
Vacant is the default 
For a recruitment action, current employee’s name displays. 
• Enter the name of the person vacating the position, or 
• Change Current to New for a position recently added 

 

7. Click the Submit Request button. 
Information pop-up displays. 

 

Proceed with Request Submission pop-up 
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8. Click the OK button. 
If the Pro Effective Date and Work Schedule hours are not complete, the page redisplays. 

Note: A red asterisk and Required Field (*Required Field) displays to the right of the 
text boxes for fields that are mandatory, but incomplete. If the mandatory fields are 
not completed, the SF-52 will not move forward. 

9. Add the mandatory information and click the Submit Request button again. 
Information pop-up displays. 

10. Click the OK button again. 
The Submission complete page displays. 

 

Requests-New Request Form (Gain)>Submission Complete page 

11. Use the options to view request details, edit the request, view the SF-52, and submit a new request. 

a. Click the magnifying glass icon  to view request details. 

b. Click the pencil icon  to edit the request. 

c. Click the 52 icon  to view the completed SF-52. 
An example of a completed SF-52 is on page 140. 

d. Click the green/yellow icon  to submit a new request. 
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Staffing Menu 

Vacancies Option 

Use the Vacancies option to view a list of all recruitment actions, electronically submitted. The Vacancies 
option allows you to view your recruitment actions, request details, track vacancies, edit requests, and 
view the SF-52. Vacancies provides access to the Staffing Module feature of WebHR. 

 

WebHR Staffing>Vacancies 

The Staffing page provides a summary of all recruitment actions submitted by your services listed in 
ARPA # order, highest to lowest. You can search by Request ID, Specialist, Organization, and Status. 

1. Open the Staffing menu. 

2. Click the Vacancies option. 
The Staffing page displays. 
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Vacancies (Staffing) page 

Note: On the Staffing page, the columns can be sorted and additional pages of records 
can be accessed. For more information, refer to page 137. 

3. Use Request ID (ARPA #) to search for a specific action: 

a. Type an ARPA number in the Request ID box. 

b. Click the calendar with binoculars icon .  

4. Use Specialist to search for recruitment actions assigned to a specific HR Staff member. 

a. Select a name from the Specialist drop-down list.  

b. Click the calendar with binoculars icon .  

5. Use Organization to search for or any actions submitted for a particular organization, service, 
department, or product line. 

a. Type an organization name in the Organization box. 

b. Click the calendar with binoculars icon . 

6. Use Status to search for approved, completed, pending, suspended, and terminated recruitment 
actions. 

a. Select one or more status check boxes in the Status drop-down list. 

b. Click the calendar with binoculars icon . 

Note: The search will only show approved and completed actions in the list of 
recruitment actions. 
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On the Staffing >Vacancies page in the Option column, you can view request details, open Vacancy 
Tracking, edit the requests, and view the SF-52. 

1. Click the magnifying glass icon  to view the request (action) details. 
Requests-Details page displays. 

2. Click the staffing icon  to access the Staffing –Vacancy Tracking page. 
The Staffing Module page displays. 

3. Click the pencil icon  to edit the request (action). 
The Requests-Editing-Part A page displays. 

4. Click the 52 icon  to view the completed SF-52. 
A sample of a completed SF-52 is on page 140. 

Request Details Page 

The Request Details page displays details regarding the selected action. These details are auto-populated 
when the action is created.  

• Request Details, Milestones, Routing Log, and Request Log are managed by WebHR system events 
and the data cannot be deleted or edited.  

• The details are updated after an SF-52 processing step is completed or an item is saved to the Log 
Item Entry Form.  

 

Requests-Details page 
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Request Details 

The Request Details section displays information specific to the selected action. 

 

Request Details section of Request-Details 

The information in Request Details is auto-populated when the action is created and the information 
cannot be modified. 
 
Field Description 
Request ID ID assigned to the request 
Type Type of action to be initiated 
Contact Name of the preparer initiating the action 
Contact Phone Phone number of the preparer initiating the action 
Status Status type of the action 
Proposed Effective Date Proposed effective date for the request 
Days in System Total number of days an action is in the WebHR system, 

from the date the SF-52 was created to the current date 
Zero (0) indicates a new request 

Affected Employee Employee specified for the action 
Assigned To Name of the specialist when the request is assigned 

Click the head icon  to access the contact information of 
the specialist to whom the request is assigned. 

Process Unit HR section working on the request 
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Milestones 

The Milestones section displays the date the SF-52 was created and the day it is approved/moved to HR 
for processing. 

 

Milestones section of Request-Details 

The information in Milestones is auto-populated when the action is created and the information cannot be 
modified. 
 
Field Description 
Entered System Date SF-52 was created 
Opened in HR Date SF-52 is approved by or moved to HR for processing 

Same as the date it was approved 
Closed Date all processing in HR is completed 

Change Status 

The Change Status section allows you to change the status of an SF-52. You cannot delete actions, but 
you can change the status types. Click the Submit Status Change button to submit the changes. 

Note: Once an SF-52 is approved, the manager can do nothing but view it. 

 

Change Status section of Request-Details 
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Field Description 
Status Types Select a status type: 

Approved 
Completed 
Pending 
Suspended 
Terminated 

Status Change Reason Enter a reason for changing a status type. 
Comments are required only for a Terminated action; 
however, you can add comments for other status types. 

Status Types in WebHR 

Status Type Description 
Approved The customer uses approved to complete an action and to indicate the 

action is ready for HR. 

Note: HR specialists should not work on any action in 
a pending status. 

Completed The specialist uses completed to indicate the action is completed and 
coded into PAID.  
• The Processing and Records unit makes the change to the 

completed status.  
• Processing and Records staff must follow local procedures when 

filing SF-52s in the E-OPF.  
• Instructions for printing a copy of the SF-52 are on page 120. 

Pending The specialist uses pending to return an action to the manager. 
• The initial status of an action is always pending. 
• Returning an action to pending allows the manager or delegate to 

make changes/updates and to move the action into an approved 
status. 

• The specialist should enter a reason for and the date of the change. 
Suspended The specialist uses suspended when HR is prevented from taking 

action.  
• When an action is placed in or changed from suspended, the 

specialist should enter a reason for and the date of the change to 
suspended. 

• The reason(s) and date(s) permanently display in the Request Log 
to retain the suspension dates of the action. 
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Status Type Description 
Terminated The customer uses terminated when HR or the approving official 

cancels an action. 
• The user must enter a reason for and the date of the change to 

terminated--it is required. 
• When a manager wants to terminate an action, HR can terminate 

the action on behalf of the manager or return the action to pending, 
so the manager can change the status to terminated.  

Log Item Entry Form 

The Log Item Entry section allows you to add comments when necessary. The log data cannot be deleted 
from the form--it is permanent.  

• A requesting official can use the log to indicate an action was reviewed and to recommend the 
approving official approve the action.  

• Click the Submit Log Entry button to send the data to the Log Item Entry Form. 

 

Log Item Entry Form section of Request-Details 

Request Log 

The Request Log section tracks what is happening to the action, as well as the how it is happening. 
Reviewing the Routing Log, you follow the action through the process from creation to Closed. 

 

Request Log section of Request-Details. 
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The information in Request Log is auto-populated and the information cannot be modified. 
 
Field Description 
User Name of the user making the update 
Item Action logged 
Type Method by which the item is handled; automatically assigned 

Routing 

The Routing section allows you to track the action as it moves from unit to unit toward completion. Each 
unit must complete all of the areas of the SF-52 for which it is responsible, in order for the action to move 
forward. Click the Route Request button to route the data to the selected unit. 

Note: Actions can be re-routed back to some other processing unit, if necessary. 

 

Routing section of Request-Details 

Field Description 
Route To Required 

Select a unit to which the action is routed: 
• Suspended Status 
• Administrative 
• Classification 
• Recruitment & Placement 
• Workforce Development 
• Employee Relations 
• Payroll 
• Workers Compensation 
• Processing & Records 
• Resource Board 
• Retirement Section 

Assign To Required 
Select a specialist to whom the action is assigned. 
If you need to change the Assign To drop-down list, contact 
your WebHR Administrator for corrections, additions, or 
changes.  

Routing Note Add a note for the next processing unit. 
The note displays in the email text and information alert sent 
to the next processing unit specialist 
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When an action is routed to a specialist, several things occur. 

• The Request Log is updated to show that the action is assigned to the specialist to whom it was 
routed.  

• The Routing Log is updated to show the Processing Unit that is working on or holding the action.  

• An Information Alert is added to the User Profile page the next time you log into WebHR. 

• An email notification is sent to the specialist assigned the action. 

 

Example of an email notification 

Routing Log 

The Routing Log section tracks the movement of the SF-52 through the processes--date entered, date 
cleared, and the number of days in a particular unit.  

 

Request Details section of Request-Details 

Field Description 
Process Unit Unit in which the SF-52 was and is currently 
Entered Date the SF-52 was routed to a particular unit 
Cleared Date the SF-52 was routed from a particular unit 

Monitor the Routing Log to verify a date is added to 
Cleared.  

Note: If there is no date, the action is not moved 
to the next unit and an email notification is 
not sent to the Contact.  
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Field Description 
Duration Number of days the action was in a particular unit 

Note: When an action is suspended, the system 
continues to count (add to) the number of 
days under Duration. 

Vacancy Tracking (Staffing Menu) 

Working in the Staffing Module (Vacancy Tracking) 

Use Vacancy Tracking to update information about the position recruitment or appointment action.  

 

Vacancies (Staffing) page 

Note: On the Staffing page, the columns can be sorted and additional pages of records 
can be accessed. For more information, refer to page 137. 

1. From the Staffing menu, Vacancies option, click the staffing icon  in the Options column. 
The Staffing-Vacancy Tracking page displays with the Request/Position Information section open. 
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Staffing-Vacancy Tracking page with the Request/Position Information section open 

2. Click the magnifying glass icon  to view the details of the selected vacancy (Requests-Details 
page). 

Request-Details page 

 

Vacancy Tracking>Requests-Details 

Use the Requests-Details page to change a status, log an item, and route a request.  

• From the Staffing-Vacancy Tracking page, click the magnifying glass icon  to view the 
requests details page. 
The Requests-Details page displays. 
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• From the Staffing page under Options, click the magnifying glass icon  next to a vacancy to 
view the requests details page. 
The Requests-Details page displays. 

3. Click the pencil icon  to edit the details of the selected vacancy (Requests-Editing-Part A page). 

Requests-Editing-Part A page 

 

Requests-Editing-Par t A page 

Use the Requests-Editing-Part A page to add/change information in Parts A, B, C, D, E, F, and 
Attachments.  

• From the Staffing-Vacancy Tracking page, click the pencil icon  to edit the request (action) 
The Requests-Editing-Part A page displays. 
or 
From the Staffing page under Options, click the pencil icon  next to a vacancy to edit the 
request (action). 
The Requests-Editing-Part A page displays. 

• For details on editing an SF-52 request, refer to Editing the SF-52 on page 98. 

4. Click the 52 icon  to view the completed SF-52 for the selected vacancy. 
A sample of a completed SF-52 is on page 140. 

5. In the sections of the Vacancy Tracking page, you can open one or more sections to view and update. 

a. Click the double down arrow icon  to close a section. 

b. Click the double up arrow icon  to open a section. 
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6. Several sections of the Vacancy Tracking page contain date fields.  
Manually enter a date or select a date from a pop-up calendar. 

• For today’s date, click Today at the bottom of the calendar. 

• Click the date box and select a date from the calendar. 

• Type in a date with the format: mm/dd/yyyy.  

 

Pop-up Calendar  

About the Vacancy Tracking Pages 

Sections of the Vacancy Tracking page contain Save buttons. You must save any data added/changed in 
each section of the Vacancy Tracking page.  

• If the save is successful, a message displays under the title of the section and includes a time stamp. 

 

Vacancy Tracking Save Successful message 

• If the save is unsuccessful or if a required field is empty, an error message displays under the 
Request/Position Information section. 

• If a required field is empty or incorrect data is entered, a red asterisk and Required Field (*Required 
Field) displays to the right of the text box.  
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Staffing-Vacancy Tracking page>Announcement Tracking 
with required fields indicated 

• In the sections of the Vacancy Tracking page, the Tool Tips feature is available for many date fields. 
Hover the cursor over a text box and the tip for entering information displays for that box.  

 

Staffing-Vacancy Tracking page>Vacancy Data with Tool Tips 
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Staffing-Vacancy Tracking Page 

Request/Position Information 

Fields on the Request/Position Information page are auto-populated when you create an SF-52 in either 
the Customer Edition or the HR Edition.  

 

Staffing – Vacancy Tracking>Request/Position Information 

Field Description 
ID Request ID or ARPA number that is automatically assigned 

when an action is created 
Action Type of action 
Status Status of the action 
Organization Organization in which the action is created 
Date SF-52 Approved Date the SF-52 is approved by the manager 
Active Days Number of days the action is active-from date approved to 

date completed 
Contact Name of the contact person 
Phone Phone number of the contact 
  
Position Title Title of the position 
Position Number Number assigned to the position  
Occupation Series Occupation series of the position 
Grade Grade of the position 
Department Department in which the action is created 
Section Section in which the action is created 
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Field Description 
Duty Station Site at which the position is located 
Work Schedule Position is full time or part time 
Vice Name from the encumbered position or Vacant 

Milestones 

In Milestones, the dates and details of each recruitment action are documented. Add/change information, 
if necessary, and click the Save Milestones button. 

 

Staffing – Vacancy Tracking>Milestones 

Field Description 
Date of Vacancy Enter the date the encumbered position was vacated or the 

date the new position was approved 
Required field, as directed by VACO 

Date Vacancy Announcement Closed This field is auto-populated when the date is entered in the 
Announcement Tracking section 

Date of Firm Offer Enter the date the firm offer is made  
Required field, as directed by VACO 
By this date all required checks, physical, etc., are cleared 

Milestone Local Use 1 Optional text field for facility-specific usage 
Enter data not covered elsewhere in the Staffing Module 
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Field Description 
Date Approved to Fill Enter the date HR received approval to fill the position 

Required field, as directed by VACO 
Example 
A facility has a hiring freeze and all positions must go to a 
committee for approval. 
• The initial date of the vacancy was 11/12/09 
• The position was approved to be filled 12/1/09  
• The service submitted the recruitment SF-52 on 11/12/09 
• The date entered in this field is 12/1/09 

Date of Tentative Selection Enter the date the selecting official or designee indicates (by 
email, letter, signature on interview form or other local form, 
verbally, or any other manner of communication) that a 
candidate submitted a resume or application, was 
interviewed, and is now considered for appointment, pending 
further processing as noted in Date of Firm Offer 
Required field, as directed by VACO 

Date of EOD Enter the effective date from Part B, block 4 of the SF-52 
Required field for Title 5 recruitments, as directed by VACO 

Milestone Local Use 2 Optional text field for facility-specific usage 
Enter data not covered elsewhere in the Staffing Module 

Announcement Tracking 

In Announcement Tracking, information about the vacancy announcement and certificates/referral listings 
are documented. Add/change information, if necessary, and click the Save Announcement Tracking 
button. 

 

Staffing – Vacancy Tracking>Announcement Tracking 
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Field Description 
Vac. Ann. Open Date Enter the date a job announcement opens 

Required field, as directed by VACO 
For open continuous, enter the beginning date of the open 
continuous announcement. 

Rating/Ranking Panel Default is No 
Select Yes, if Panel is held 

Date Vac. Ann. Certificate to Service Enter the date a list of eligible candidates was sent to the 
selecting official 
Required field, as directed by VACO 

DEU Open Date Enter the date a job announcement is posted from the 
Delegated Examining Unit (DEU), if applicable 

Date DEU Cert Received in HR Enter the date the certificate of eligible candidates is received 
from DEU, if applicable 

Date DEU Cert Returned from 
Service to HR 

Enter the date the certificate of eligible candidates is returned 
to HR from the selecting official, if applicable 

Vac. Ann. Local Use 6 Optional text field for facility-specific usage 
Enter data not covered elsewhere in the Staffing Module 

  
Vac. Ann. Close Date Enter the date a job announcement closes  

Required field, as directed by VACO 
For open continuous, enter the date the certificate is issued or 
the cut-off date for the announcement. 

Date Rating/Ranking Panel Enter the date a panel is held, if applicable 
Required field, as directed by VACO 

Date Vac. Ann. Certificate from 
Service 

Enter the date HR receives the certificate of eligible 
candidates back from the selecting official 

DEU Close Date Enter the date a job announcement is closed by the DEU, if 
applicable 

Date DEU Cert from HR or DEU to 
Service 

Enter the date the certificate of eligible candidates is given to 
the selecting official, if applicable 

Date HR Returned DEU Cert to 
DEU 

Enter the date the DEU certificate was sent back to DEU 
with selection/non selection information, if applicable 

Vac. Ann. Local Use 7 Optional text field for facility-specific usage 
Enter data not covered elsewhere in the Staffing Module 
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Additional Authorization (Optional) 

In Additional Authorizations, additional authorizations required at your facility are documented. The use 
of Additional Authorizations is optional. Add/change information, if necessary, and click the Save 
Authorizations button. 

Note: Leadership is defined by the HRO and is possibly at the Resources Committee, 
TRIAD, VISN level of approval. 

 

Staffing – Vacancy Tracking>Additional Author izations (Optional) 

Field Description 
Leadership Recruit Enter the date, if the position requires leadership approval 
Delay Start Enter the start date of the delay, if there was a delay in 

beginning the recruitment process, e.g., waiting for relocation 
expenses to be approved 

Date Assigned to Staffer Enter the date the action was assigned 
Additional Local Use 4 Optional text field for facility-specific usage 

Enter data not covered elsewhere in the Staffing Module 
  
Leadership Commit Enter the date leadership gave approval to make firm 

commitment, if the position requires leadership approval to 
commit selected candidate 

Delay End Enter the date the delay ended 
Additional Local Use 3 Optional text field for facility-specific usage 

Enter date data not covered elsewhere in the Staffing Module 
Additional Local Use 5 Optional text field for facility-specific usage 

Enter date data not covered elsewhere in the Staffing Module 
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Vacancy Data 

In Vacancy Data, information about the vacancy is documented. Add/change information, if necessary, 
and click the Save Vacancy Data button. 

 

Staffing – Vacancy Tracking>Vacancy Data 

Field Description 
Vacancy Ann. Number Enter the local facility announcement number 
FTEE Enter the number of full time equivalents authorized for this 

position 
Area of Consideration (AOC) Select an area of recruitment consideration from the drop-

down list: internal, external, or both 
Required field, as directed by VACO 
The default is internal 

Number Internal Applicants Enter the total number of internal applicants that applied  
Number External Applicants Enter the total number of external applicants 
Number Notified NQ Enter the total number of applicants not qualified 
Number Notified of Outcome Enter the total number of applicants notified of the vacancy 

outcome 
Selecting Official Enter the name and the title of the selecting official 
Recruitment Cancelled Default is No 

Change to Yes, if applicable 
Vac. Data Local Use 8 Optional text field for facility-specific usage 

Enter text data not covered elsewhere in the Staffing Module 
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Field Description 
Specialist Select the name of the Human Resources staff member 

assigned to work the recruitment action from drop-down list 
  
Status Select a status for the recruitment process: Pending, Opened, 

Closed, Active, or Finalized from the drop-down list 
Status changes throughout the process, e.g., the status 
changes to active when the certificate is issued.  
• Pending – vacancy is in the review process and the 

vacancy announcement is being prepared  
• Opened – job announcement is open and applications are 

being accepted 
• Closed – job announcement is closed; qualifications are 

being reviewed and certificates are being prepared 
• Active – certificate is issued   
• Finalized – selection is made and position filled 

Category Select a category for the position: Title 5, Title 38, Research, 
Hybrid, or Other from the drop- down list 
The default is Title 5 

Total Number Applicants Enter the total number of applicants that applied 
Required field for Title 38 only, as directed by VACO 

Number Applicants Qualified Not 
Referred 

Enter the number of applicants qualified, but not referred for 
consideration 

Total Number Interviewed Enter the total number of applicants interviewed, if 
interviews were conducted 

Date Interviews Completed Enter the date interviews were completed, if interviews were 
conducted  
Required field, as directed by VACO 

Date Applicants Notified of Outcome Enter the date notifications were sent via mail or email 
Need to Re-announce Default is No 

Change to Yes, if applicable 
Vac. Data Local Use 9 Optional text field for facility-specific usage 

Enter date data not covered elsewhere in the Staffing Module 
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Selectee Tracking 

In Selectee Tracking, information about the selectee is documented. Add/change information, if 
necessary, enter dates where applicable to the selected candidate, and click the Save Selectee Tracking 
button. 

 

Staffing – Vacancy Tracking>Selectee Tracking 

• When the candidate is not a physician, the fields associated with a Physician Comp Panel remain 
blank.  

• When an internal candidate is selected, the majority of the date fields are not applicable and do 
not require dates. 

 
Field Description 
Name of Selectee Enter name of the individual selected to fill the position 
AOC Selected from Use drop down menu to select Area of Consideration: 

Internal, External, or Both 
Required field, as directed by VACO 

Type of Background check Select type of investigation from drop down menu, if 
applicable: SAC Only, NACI, MBI, or BI 
N/A is the default 

Date SAC Results Adjudicated Special Agency Check (SAC) 
Enter date SAC results were adjudicated 
Required field, as directed by VACO 

Date Background Check Results 
Received 

Enter date background check results were received 
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Field Description 
Date Credentialing Started (VetPro) Enter date credentialing started 

Required field for Title 38 only, as directed by VACO 
Date All Required Verifications 
Complete & Databanks Cleared 

Enter date all required verifications were completed and 
databanks were cleared 
Required field, as directed by VACO 

Date of Physician Comp Panel Enter date of the physician comp panel 
Required field for Title 38 only, as directed by VACO 

Date of Medical Exam Enter date of the medical exam 
Required field for Title 38 only, as directed by VACO 

Selectee Local Use 10 Optional text field for facility-specific usage 
Selectee Local Use 12 Optional text field for facility-specific usage 
  
Date Selectee Contacted Enter date the selectee was first contacted 

Required field, as directed by VACO 
Date Fingerprints Taken (SAC) Enter date fingerprints were taken 

Required field, as directed by VACO 
Date SAC Results Received Enter date SAC results were received 
Date Background Check Initiated 
(eQIP) 

Enter date background check was initiated 
Required field for Title 5 only, as directed by VACO 

Date Background Check Results 
Adjudicated 

Enter date background check results were adjudicated 

Date Credentialing Completed 
(VetPro) 

Enter date credentialing was completed 
Required field for Title 38 only, as directed by VACO 

Date of Professional Standards 
Board 

Enter date of the Professional Standards Board 
Required field for Title 38 only, as directed by VACO 

Date Privileges Approved (optional) Enter date privileges were approved 
Date Medical Exam Cleared Enter date medical exam was cleared 

Required field for Title 38 only, as directed by VACO 
Selectee Local Use 11 Optional date field for facility-specific usage 
Selectee Local Use 13 Optional date field for facility-specific usage 

Note: When the Local Use fields are used for data not otherwise available in the Staffing 
Module, you need to develop a local key for staff.  

• WebHR is a global application, so you cannot rename the fields in the Staffing 
Module.  

• You must keep track of the local key for all Local Use fields identified for your 
station/facility.  
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Remarks 

In Remarks, national and local comments about the selectee are documented. Add/change information, if 
necessary, and click the Save Remarks button. 

 

Staffing – Vacancy Tracking>Remarks 

Field Description 
National Remarks Enter comments for national reporting, i.e., VA Central 

Office needs to know this action was filled from an open 
continuous announcement, the reason for a delay, or not 
meeting the measure 

Local Remarks Enter comments at the facility level; these remarks are not 
used for national reports 

 

Staffing (Module) Reports 

The Staffing Reports are in the Reports menu in the WebHR Automated HR Edition. Data entered by HR 
staff into the Staffing Module/Vacancy Tracker auto populates the staffing reports. There are eight 
staffing reports.  

• These reports assist with tracking HR measurements: recruitment activity and metrics information 
and are populated with data entered by HR staff in the Vacancy Tracker.  

• To return to WebHR after reviewing the report, click X in the upper right corner of the report. 
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These reports are available in three formats.  

•  The Flat file icon allows you to download and have access to .pdf-like features. 

•  The Excel file icon allows you to download and have access to Excel features.   

•  The MS Word file icon allows you to download and have access to MS Word features. 

 

(Staffing) Repor ts – HR Measurements 

Note: Validate all data in the reports to ensure the information populates correctly. 

• The data gathered in the staffing reports, provides reports and statistical information 
to management in VHA, VA, OPM, and other agencies, upon request.  

• The requests for performance measures for each step in the recruitment process 
include the staffing process, statistical information, and metrics information. 

1. Open the Reports menu. 

2. Click the Staffing Reports option. 
The Reports–HR Measurements page displays. 

3. Select a report format. 
The selected report displays. 

4. Click X in the upper right corner of the browser, to return to WebHR after reviewing the report. 

Metrics–Calendar Days 

The Metrics–Calendar Days report calculates the number of calendar days for completed/approved action 
in 11 categories based on data entered into the applicable fields in the Staffing Module.  

Metrics–Work Days 

The Metrics–Work Days report calculates the number of work days for completed/approved action in 11 
categories based on data entered into the applicable fields in the Staffing Module. 



 

October 2011 WebHR C3-C1 Conversion Project 47 
 User Manual for the Automated HR Edition (WEBH*) 

Recruitment Listing 

The Recruitment Listing report contains all the fields in the Staffing Module plus fields that are calculated 
from the data entered into the Staffing Module. This report lists recruitment actions in the 
approved/pending/suspended status. Some of the fields contain auto-calculated data from the module.  

Closed/Completed Recruitment Actions 

The Closed/Completed Recruitment Actions report contains all the fields in the Staffing Module plus 
fields that are calculated from the data entered into the Staffing Module. This report lists recruitment 
actions in the completed/terminated status. Some of the fields contain auto-calculated data from the 
module. 

Management Report Recruitment Actions 

The Management Report Recruitment Actions report provides a list of the recruitment actions in the 
approved/pending/suspended status. It is an overview of an action from vacancy to Entrance on Duty 
(EOD). 

Closed/Completed Management Report Recruitment Actions 

The Closed/Completed Management Report Recruitment Actions report provides a list of recruitment 
actions in a completed/terminated status. It is an overview of an action from vacancy to Entrance on Duty 
(EOD). 

Summary Report 

The Summary Report is a synopsis of a recruitment activity, including announcement open/close dates, 
number of candidates, certificate dates, etc. for all approved/completed actions. 

Selectee Tracking 

This report consolidates information on approved/completed actions regarding the selection and related 
criteria for hiring internal and external candidates. 
Selectee Tracking Report contains all of the data fields from the Selectee Tracking section of the Staffing 
Module; refer to Selectee Tracking on page 43.  
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Requests Menu 
Many reports are generated from the work completed under the Requests menu, from which you create, 
process, code, return, and track SF-52s, as well as create and approve actions. 

 

WebHR>Requests menu 

New Request Option 

Use the New Request option to create a new SF-52, but any action created in the HR Edition, is only 
visible in the HR edition. 

1. Open the Requests menu. 

2. Click the New Request option. 
The Action Types list box displays--an alphabetical list of all actions for a request.  

Note: The Action Types list uses the actual terms from the PAID system. These terms 
may be different from what was typed on a manually completed SF-52. Terms 
such as Hire or Quit are not on the list. There are multiple actions with appended 
details, i.e., Retirement, Retirement Disability, Retirement ILIA, or Retirement 
Mandatory.  
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New Requests>Requests-Submissions page 

Note: The request submission pages that display vary depending on the type of action 
you initiate. 

3. On the Requests-Submission page, from the Action Types list select a Recruitment action. 
Requests-New Request Form (Gain) page displays. 

 

Requests-New Request Form (Gain) page for  a recruitment action 

4. Review the Requests-New Request Form (Gain) page.  
Verify the information. 

Request Type 

5. Pro Effective Date is a required field 
Manually enter a date or select a date from a pop-up calendar. 

• For today’s date, click Today at the bottom of the calendar. 
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• Click the date box and select a date from the calendar. 

• Type in a date with the format: mm/dd/yyyy.   

 

Pop-up Calendar  

Action Requested By and Action Authorized By 

6. Optional: Update/change the name(s) in the Action Requested by and Action Authorized by sections. 
Action Requested By and Action Authorized By are auto-populated, only in the HR Edition, with 
the name of the station HRO. 

• If this information is changed by a person outside of HR, the action is not visible. 

• Once the action is submitted, the Action Requested By and Action Authorized By fields cannot 
be edited. 

For Additional Information Call 

7. Change/update the contact information, if necessary. 
The Contact information defaults to the user who is logged on and initiating the SF-52; however, the 
user can change this information. 

Part B To and Part B Position Data 

8. Ensure the correct site is selected in Part B Position Data. 
The Part B To and Part B Position Data sections are auto-populated. For a table of Part B To and Part 
B Position Data fields, refer to page 19. 

9. Click the Submit Request button. 
Information pop-up displays. 

 

Proceed with Request Submission 
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10. Click the OK button. 
If the Pro Effective Date and Work Schedule hours are not complete, the page redisplays. 

Note: A red asterisk and Required Field (*Required Field) displays to the right of the 
text boxes for fields that are mandatory, but incomplete. If the mandatory fields are 
not completed, the SF-52 will not move forward. 

11. Add the mandatory information and click the Submit Request button again. 
Information pop-up displays. 

12. Click the OK button. 
Submission complete page displays 

 

Requests-New Request Form (Gain)>Submission Complete page 

13. Click the magnifying glass icon  to view request details. 

14. Click the pencil icon  to edit the request. 

15. Click the 52 icon  to view the completed SF-52. 
An example of a completed SF-52 is on page 140. 

16. Click the green/yellow icon  to submit a new request. 

View All Requests Option 

Use the View All Requests option to view all requests for actions submitted by all services listed in 
numerical order. Use the individual filter and search features at the top of the page to display specific 
actions. Each search is independent and cannot be combined with a second search. Search by Request ID, 
Status, Process Units, Category, or Specialist.  

1. Open the Requests menu. 

2. Click the View All Requests option. 
The Requests page displays. 

Note: Do not press Enter after a selection from the Process Units, Category, and 
Specialist drop-down lists. 
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Requests>View All Requests 

 

Requests>View All Requests page, search options 

Note: On the Requests page, the columns can be sorted. For more information, refer to 
page 137. 

3. Use the Request ID text box to search for a specific action by action number. 

a. Type an action number in the Request ID box. 

b. Click the calendar with binoculars icon . 

4. Use the Status text box to search for actions in a specific status. 

Note: The status default for all actions is Approved. 

a. Select a status from the Status drop-down list. 
• Approved 
• Completed 
• Pending  
• Suspended 
• Terminated 

b. Click the calendar with binoculars icon . 
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5. Use the Process Units text box to search for actions by units. 

a. Select a unit from the Process Units drop-down list.  

• Suspended Status 

• Administrative 

• Classification 

• Recruitment & Planning 

• Workforce Development 

• Employee Relations 

• Labor Relations 

• Payroll 

• Workers Compensation 

• Processing & Records 

• Resource Board 

• Retirement Section 

b. The summary of actions displays. 

6. Use the Category text box to search for actions by category. 
Select a type of action from the Category drop-down list. The summary of actions displays. 
• Gains – list of all recruitment and appointment SF-52s 
• Losses – list of all retirements, terminations, and separations SF-52s 
• Employee – list of all employees 

7. Use the Specialist text box to search for actions assigned to a specific member of the HR staff. 
Select a name from the Specialist drop-down list. The summary of actions displays. 

8. Use the Options in the first column to view a request, edit a request, view an SF-52, or view 
supporting documentation. 

a. Click the magnifying glass icon  to view request details. 

b. Click the pencil icon  to edit the request. 

c. Click the 52 icon  to view the SF-52.  

d. Click the paperclip icon  to view supporting documentation previously attached. 

My Assigned Requests Option 

Use the My Assigned Requests option to view all requests for actions assigned to you, based on the login 
address.  

• You receive an Outlook email indicating an ARPA action was assigned.  

• The assigned action that requires attention displays on the Requests-Specialists page. 
 



 

54 WebHR C3-C1 Conversion Project October 2011 
 User Manual for the Automated HR Edition (WEBH*) 

Use the individual filter and search features at the top of the page to display specific actions. You can 
search by Request ID, Status, ProcessUnits, or Category. 

 

Requests>My Assigned Requests>Requests-Specialists page 

Note: On the Requests-Specialists page, the columns can be sorted. For more 
information, refer to page 137. 

1. Open the Requests menu. 

2. Click the My Assigned Requests option. 
The Specialists page displays. 

Note: Do not press Enter after a selection from the Status, ProcessUnits, or Category 
drop-down lists. 

3. Use the Request ID text box to search for a specific action by action number. 

a. Type an action number in the Request ID box. 

b. Click the calendar with binoculars icon . 

4. Use the Status text box to search for actions in a specific status. 

Note: All Approved actions is the default. 

a. Select a status from the Status drop-down list. 
• Approved 
• Completed 
• Pending  
• Suspended 
• Terminated 

b. Click the calendar with binoculars icon . 

5. Use the ProcessUnits text box to search for actions by units. 

a. Select a unit from the ProcessUnits drop-down list.  
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• Suspended Status 

• Administrative 

• Classification 

• Recruitment & Planning 

• Workforce Development 

• Employee Relations 

• Labor Relations 

• Payroll 

• Workers Compensation 

• Processing & Records 

• Resource Board 

• Retirement Section 

b. The summary of actions displays. 

6. Use the Category text box to search for actions by category. 
Select a type of action from the Category drop-down list. The summary of actions displays. 
• Gains – list of all recruitment and appointment SF-52s 
• Losses – list of all retirements, terminations, and separations SF-52s 
• Employee – list of employees 

7. Use the Options in the first column to view a request, edit a request, view an SF-52, or view 
supporting documentation. 

a. Click the magnifying glass icon  to view request details.  

b. Click the pencil icon  to edit the request. 

c. Click the 52 icon  to view the SF-52. 

d. Click the paperclip icon  to view supporting documentation previously attached. 

Workload Option 

Use the Workload option to view lists of Organizations, Processing Units, and Specialists and to generate 
results to display in an SF-52 action workload of an organization, processing unit, or specialist. 

• Each of the displays identifies the total number of actions assigned in each category, but does not list 
the actions individually.  

• A supervisor or other HR staff can view overall activity and if necessary, assign SF-52s to other 
specialists depending on backlog and volume. 
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Workload>Organizations 

 

Requests>Workload>Organizations 

Note: In the tables on the ARPA Workload>Organizations page, the columns can be 
sorted. For more information, refer to page 137. 

1. Open the Requests menu. 

2. Select the Workload option>Organizations option. 
The ARPA Workload-Organizations page displays. 

 

Example of Workload>Organizations 

3. Click the right arrow icon  to view all approved actions (SF-52s) for the selected organization. 
Workload - Organizations expands and displays approved SF-52s for each organization. 
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Workload>Organizations expanded 

Workload>Processing Units 

 

Requests>Workload>Processing Units 

Note: In the tables on the ARPA Workload>Processing Units page, the columns can be 
sorted. For more information, refer to page 137. 

1. Open the Requests menu. 

2. Click the Workload option>Processing Units option. 
The ARPA Workload-Processing Units page displays. 
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Example of Workload>Processing Units 

3. Click the right arrow icon  to view all approved actions (SF-52s) for the selected processing unit. 
Workload - Processing Units expands and displays approved SF-52s for each unit. 

 

Workload>Processing Units expanded 

Workload>Specialists 

 

Requests>Workload>Specialists 
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Note: In the tables on the Workload>Specialists page, the columns can be sorted. For 
more information, refer to page 137. 

1. Open the Requests menu. 

2. Click the Workload option>Specialists option. 
The Requests-Workload-Specialists page displays. 

 

Example of Workload>Specialists 

3. Click the right arrow icon  to view all approved actions (SF-52s) for the selected specialist. 
Workload - Specialists expands and displays approved SF-52s assigned to each specialist. 

 

Workload>Specialists expanded 

4. Use the Options in the first column to view a request, edit a request, view an SF-52, or view 
supporting documentation. 

a. Click the magnifying glass icon  to view request details. 
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b. Click the pencil icon  to edit the request. 

c. Click the 52 icon  to view the SF-52. 

d. Click the paperclip icon  to view supporting documentation previously attached. 

ARPA Action Types Option 

Use the ARPA Action Types option to view a list of descriptions for all the available ARPA action types. 
The list serves as a reference to assist in the processing of SF-52s. 

1. Open the Requests menu. 

2. Click the ARPA Action Types option. 
The Action Types page displays. 

 

ARPA Action Types 

Note: On the Lists-Action Types page, the columns can be sorted. For more information, 
refer to page 137. 
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Legal Authority List Option 

Use the Legal Authority List option to view a list of legal authorities with codes and dates of the last 
update for each. The list serves as a reference to assist in the processing of SF-52s. 

1. Open the Requests menu. 

2. Click the Legal Authority List option. 
The Legal Authority page displays. 

 

Legal Author ity List 

Note: On the Lists-Legal Authority page, the columns can be sorted. For more 
information, refer to page 137. 
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Nature of Action List Option 

Use the Nature of Action List option to view a list of actions with NOA codes for each action. The list 
serves as a reference to assist in the processing of SF-52s. 

1. Open the Requests menu. 

2. Click the Nature of Action List option. 
The Nature of Action Codes page displays. 

 

Nature of Action List 

Note: On the Lists-Nature of Action page, the columns can be sorted. For more 
information, refer to page 137. 
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PAID Menu 

 

PAID menu 

Search Option 

1. Open the PAID menu. 

2. Click the Search option. 
The Employee Listing page displays. 

3. Click the All button or type criteria into the text boxes: Last Name, Occ Code, Pos No, or Org Code 
and click the binoculars icon .  
A list of all employees or employees meeting the criteria displays.  

 

WebHR PAID Employee Listing 
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Note: On the PAID-Employee Listing page, the columns can be sorted and additional 
pages of records can be accessed. For more information, refer to page 137. 

4. Click the magnifying glass icon  next to an employee name to view PAID record information. 
PAID – Employee Record displays for the selected employee. 
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WebHR>PAID – Employee Record 
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5. Click the green/yellow icon  next to an employee name to initiate an SF-52 for the selected 
employee.  
PAID – Employee Details displays for the selected employee. 

 

PAID-Employee Details page 

6. History is a list of all SF-52s created in WebHR for the selected employee. 

a. Click the magnifying glass icon  to display the ARPA Request Details page for the selected 
employee. 

b. Click the 52 icon  to view the completed SF-52. 

Initiate an SF-52 from PAID-Employees Details 

1. Select a Promotion action from the Action Types list.  

2. Click the Start Request For Action button. 
Requests-Submission page displays. 

Note: The request submission pages that display vary depending on the type of action 
you initiate. 

 

Requests-Submission page 
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3. Type one or more letters in the Last Name box and click the calendar with binoculars icon . 
List of employee names displays. 

 

Requests Submission-Employee list page 

4. Click the green/yellow icon  next the employee for whom to create a request for action. 
The Request-Submission-Employee: Action page for the selected employee displays. 

 

Requests Submission-Employee: Action page for  a promotion 
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Requested By and Authorized By 

5. Optional: Update/change the name(s) in the Requested by and Authorized by sections. Requested By 
and Authorized By are auto-populated, only in the HR Edition, with the name of the station HRO. 

• If this information is changed by a person outside of HR, the action is not visible. 

• Once the action is submitted, the Requested By and Authorized By fields cannot be edited. 

6. Change the contact information, if necessary. 
The Contact information defaults to the user who is logged on and initiating the SF-52; however, the 
user can change this information. 

7. Pro Effect Date is a required field 
Manually enter a date or select a date from a pop-up calendar. 

• For today’s date, click Today at the bottom of the calendar. 

• Click the date box and select a date from the calendar. 

• Type in a date with the format: mm/dd/yyyy.   

 

Pop-up Calendar  

Part B To and Part B Position Data 

8. Ensure the correct site is selected in Part B Position Data. 
Part B, Part B From, and Part B Employee Data are auto-populated with current data from PAID. 

 
Field Description 
Part B To 
Refers to the requested action 
Title Position title 
Number Required 

Same as Position Description (PD) Number 
Pay Plan Pay plan identifies the pay system under which the 

employee’s compensation is determined 
Series Series is the same as Occupation Series Code (Occ Code) 
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Field Description 
Local Adj Local adjustment is the pay amounts established as 

supplemental pay, based on higher cost of living assessments 
in some geographical areas; if unknown, can be left blank 

Comp Level Competitive level identifies positions in a competitive area 
that are in the same grade or occupational level; if unknown, 
can be left blank 

Grade Grade is the specific identifier that indicates pay level within 
a pay plan system 

Salary Base salary for position 
Adj Basic Pay Adjusted basic pay; if unknown, can be left blank 
Pay Basis Pay basis identifies the principal condition that serves as a 

basis for computing pay; if unknown, can be left blank 
Basic Pay Basic pay is the amount in the general pay tables for the 

grades; if unknown, can be left blank 
Other Pay Other pay depends on the position; if unknown, can be left 

blank 
Part B Position Data 
Refers to the Position 
Site Duty Station 

Use the Site drop-down list to ensure the correct site is 
selected; change if necessary. 

Pos Occ Position Occupied 
Designated for HR 

New Pos New Position 
Designated for HR 

QTU Qualifications Standards Used  
Designated for HR 

Citizen Designated for HR 
Work (FT or PT) 
a. Work 
b. Schedule 

 
a. Select Full-time, Part-time, or Intermittent 
b. Enter hours scheduled per pay period 

FLSA FLSA Category 
Designated for HR 

Regraded Regraded is a change to a position’s classification 
Designated for HR 

Ed Level Designated for HR 
Vietnam Designated for HR 
ApprCode Appropriation code is a combination of a 4-digit 

organizational code and a 4-digit cost center code 
Add or change, if necessary 
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Field Description 
Vice VICE is the name of a previous employee for a vacant 

position 
N/A when the requested action is not a fill/recruitment 
For a recruitment action, current employee’s name displays. 
• Enter the name of the person vacating the position, or 
• Change Current to New for a position recently added 

IA Pos IA Position 
Designated for HR 

Fntc Cls Designated for HR 
Degree Yr Year degree attained 

Designated for HR 
BusCode Bargaining Unit Status (BUS) code of the employee’s 

position 
Add or change, if necessary 

Supvl Supv Status 
Designated for HR 

 
9. Review all information to ensure the coding is correct. 

Add/change where necessary. 

10. Click the Submit Request button. 
Information pop-up displays. 

 

Proceed with Request Submission pop-up 

11. Click the OK button. 
If the Pro Effect Date is not complete, the page redisplays. 

Note: A red asterisk and Required Field (*Required Field) displays to the right of the 
text boxes for fields that are mandatory, but incomplete. If the mandatory fields are 
not completed, the SF-52 will not move forward. 

12. Add the mandatory information and click the Submit Request button again. 
Information pop-up displays. 

13. Click the OK button again. 
Request Details page displays. 
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Requests-Details 

To complete an SF-52 from PAID-Employees Details, refer to Request –Details on page 24. 

Explorer Option 

1. Open the PAID menu. 

2. Click the Explorer option. 
PAID – Unit Explorer page displays with lists to which you have access: Organizations and 
Employees. 

 

PAID>Unit Explorer  
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Organizations 

• Organizational structure of the site or VISN; organizations currently mapped for the site. 

• Organization tree contains the service line names with organization code and cost center code. 

• To view subordinate service lines, click an organization name.  

• If an organization is missing, contact your local WebHR Administrator. 

Note: WebHR is based on appropriation codes–the organization code combined with the 
cost center code. Organizations are structured in a hierarchy using the 
appropriation codes for sub-organizations. 

Employees 

• A list of employees for a selected organization (service line) 
• Employees assigned to a particular appropriation code in PAID/VistA 
• On the Employees listing, the employee name, occupation, position number (Pos #), pay plan (PP), 

and series displays.  
• In the Employees table on the PAID-Unit Explorer page, the columns can be sorted. For more 

information, refer to page 137. 

Selected Employee Unit/Service Line Detail 

When an organization is selected, information about the organization displays on the lower left side of the 
page. 

 

Service Line detail for  Human Resources 

3. To drill down through the organizations (service lines), click the name of a service line. 
The details of the selected organization and employees assigned to the selected service line display. 

Notes: This information can be copied/pasted into an Excel spreadsheet for future 
reference. No printing can be done from within the WebHR application. 

4. Click the head icon  to select an employee on which to initiate an SF-52. 
PAID-Active Employees List displays. 
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Active Employees List Option 

1. Open the PAID menu. 

2. Click the Active Employees List option. 
The Active Employees List page displays. 

 

WebHR>PAID>Active Employees List 

Note: On the PAID-Active Employees List page, the columns can be sorted and 
additional pages of records can be accessed. For more information, refer to page 
137. 

3. Click the magnifying glass icon  to display an employee’s PAID record.  

4. Click the green/yellow icon  next to a name to initiate an SF-52 for that individual. 
The PAID-Employee Details page displays. 

 

PAID-Employee Details page 
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5. Select an action from the Action Types list. 

6. Click Start Request for Action. 
Request-Submission-Employee: Action= page displays. 

7. To complete the submission, continue with step 6 on page 66. 

Costcenters and Organizations Option  

Costcenters and Organizations is a list of codes for organizations and cost centers established for a 
facility. It contains the CCCODE (cost center code) and ORGCODE (organizational code) combination to 
enter in the Appropriation field of an SF-52. This list is used as a reference when preparing SF-52s. 

1. Open the PAID menu. 

2. Click the Costcenters and Organizations option. 
The Cost Centers and Organizations page displays. 

 

PAID-Cost Centers and Organizations 

Note: On the PAID-Cost Centers and Organizations page, the columns can be sorted. For 
more information, refer to page 137. 

 
 
 



 

October 2011 WebHR C3-C1 Conversion Project 75 
 User Manual for the Automated HR Edition (WEBH*) 

System Menu 

 

System menu 

Users>Roles Option for WebHR Administrators only 

The local administrator handles Users>Roles, which is where roles are assigned, changed, or deleted for 
users. 
Only WebHR Administrators can access the Users>Roles option. HR Specialists do not. The local 
WebHR Administrator handles assigning, changing, and deleting role types for WebHR users. 

1. Open the System menu. 

2. Select the Users option and click the Roles option. 
The Role Management page displays with an alphabetical list of registered users displays: Name, 
Title, Organization, and Agent Type, with Role Management information at the bottom of the page. 

Note: If a name is not in the list, the user does not have an agent type assigned. 
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WebHR list of registered users with Role Management infor mation 

Note: On the System-Users-Role Management page, the columns can be sorted. For more 
information, refer to page 137. 

3. To assign roles to the users: 

a. Click the person icon . 
Under Registered Users, the selected user is highlighted and the Role Management box displays. 

 

WebHR page with selected user  highlighted and Role Management information displayed 

b. In Role Management, select a role assignment from the list. 
Role assignment is based on the responsibilities of the user. 
• If any roles were previously assigned, the Assigned Roles list displays.  
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• If no roles were previously assigned, only the Role Assignment list displays.  

c. Click the Add User to Role button. 
New user role displays under Assigned Roles. 

 

Role Management section displaying the user ’s new role assignment 

d. Click the X in a red circle icon  next to an assigned role to remove a role.  

Note: Most users are assigned as a preparer, requester or approver; the other role 
assignment types are rarely used.   

e. Once both the appropriate Agent type and Role type assignments are assigned, the user has access 
to WebHR.  
• Only users assigned the Specialist role can access the HR Edition.  
• Users assigned the preparer, requester, and approver role types can access the Customer 

Edition. 

4. Select another (user) person icon  and repeat step 3 to add another role type. 

Configuration Option for HTM HRIS Staff only 

The Configuration Option is available only to HTM HRIS staff members.  

 

ARPA Action Types for  HRIS staff only 
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Note: Only the HTM HRIS staff can edit the configuration pages; but users can view the 
active action types and sort columns; the Edit buttons are not available to users. 

1. Open the System menu. 

2. Select the Configuration option and click the ARPA Action Types option. 
The active action types page displays. 

 

System>Configuration>ARPA Action Types 

Note: On the System-Configuration-Action Types page, the columns can be sorted. For 
more information, refer to page 137. 

3. Click the pencil icon  to select an action type. 

4. Select a mode: Edit or Add New. 

5. Populate the form fields. 

6. Click the Edit Record or Insert New Record button to save the edits or additions. 

ARPA NOA Codes for HTM HRIS Staff only 

1. Open the System menu. 

2. Select the Configuration option and click the ARPA NOA Codes option. 
The Notice of Action Codes page displays. 
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System>Configuration>ARPA NOA Codes 

Note: On the System-Configuration-Notice of Action Codes page, the columns can be 
sorted. For more information, refer to page 137. 

3. Click the pencil icon  to select a code. 

4. Select Edit Mode or Insert Mode. 

5. Populate the form fields. 

6. Click the Edit NOA Code or Add NOA Code button to save the code edits or additions. 
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ARPA LA Codes for HTM HRIS Staff only 

1. Open the System menu. 

2. Click the Configuration>ARPA LA Codes option. 
The Legal Authority Codes page displays. 

 

System>Configuration>Legal Author ity Code 

Note: On the System-Configuration-Legal Authority Codes page, you can sort the 
columns. For more information, refer to page 137. 

3.  Click the pencil icon to select a code. 

4. Select Edit Mode or Insert Mode. 

5. Populate the form fields. 

6. Click the Edit Legal Authority Code or Add Legal Authority Code button to save code edits or 
additions. 
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Tenure Codes for HTM HRIS Staff only 

1. Open the System menu. 

2. Click the Configuration>Tenure Codes option. 
The Tenure Codes page displays with a warning message. 

Shield with an exclamation point icon  Tasks performed on this page have a system-wide effect on 
HR applications, please observe caution. 

 

System>Configuration>Tenure Codes 

Note: On the System-Configuration-Tenure Codes page, you can sort the columns. For 
more information, refer to page 137. 

3. Click the pencil icon  to select a code. 

4. Select Edit Mode or Insert Mode. 

5. Populate the available fields. 

6. Click the Edit Tenure Code/Remove Record or Add Tenure Code button to save code 
edits/removals or additions. 
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Veterans Preference Codes for HTM HRIS Staff only 

1. Open the System menu. 

2. Click the Configuration>Veterans Preference Codes option. 
The Veterans Preference Codes page displays with a warning message. 

Shield with an exclamation point icon  Tasks performed on this page have a system-wide effect on 
HR applications, please observe caution. 

 

System>Configuration>Veterans Preference Codes 

Note: On the System-Configuration-Veterans Preference Codes page, you can sort the 
columns. For more information, refer to page 137. 

3. Click the pencil icon  to select a code. 

4. Select Edit Mode or Insert Mode. 

5. Populate the form fields. 

6. Click the Edit Veterans Preference Code/Remove Veterans Preference Code button to save code 
edits/removals or additions. 
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Document Management for HTM HRIS Staff only 

1. Open the System menu. 

2. Click the Document Management option. 
The Document Management page displays. 

 

System>Configuration>Document Management 

Note: On the System-Document Management page, you can sort the column. For more 
information, refer to page 137. 

3. To add a document: 

a. Select an application. 

b. Select a type. 

c. Browse to the location of the document. 

d. Add a description of the document. 

e. Click the Add Document button. 

4. To view a document, click the flat file icon  next to the document. 

5. To remove a document, click the X in a red circle icon  next to the document. 
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Messaging Option for HTM HRIS Staff only 

The Messaging Option is available only to HTM HRIS staff members. Only HTM HRIS staff can edit the 
messaging page and the Add button is not available to users. 

 

System>Messaging 

1. Open the System menu. 

2. Click the Messaging option. 
The Bulletin Board page displays. 

 

System>Messaging>Bulletin Board 
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3. Add a message to the bulletin board for the HR Edition and/or the CE Edition of WebHR. 

a. Select an audience. 

b. Add the message for the bulletin board. 

c. Enter the Display Until date. 

d. Click the Add Bulletin button. 
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Help Menu 
The Help menu contains three items: Documents, Guides, and Contact Us. You can view Help documents 
for assistance with WebHR. 

 

WebHR page with the Help menu open 

Documents Option 

 

The Documents option contains several documents to assist you in using WebHR HR Edition.  

1. Open the Help menu. 

2. Select Documents. 

3. Click a document title. 

4. Open to view or download and save to your computer.   
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Guides Option 

The Guides option contains access to guides that assist you in processing an SF-52. 

 

Help>Guides>Processing Personnel Actions 

1. Open the Help menu. 

2. Select Guides. 

3. Click the Processing Personnel Actions option. 
Guide to Processing Personnel Actions displays. 
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OPM Documentation Home page 



 

October 2011 WebHR C3-C1 Conversion Project 89 
 User Manual for the Automated HR Edition (WEBH*) 

Contact Us Option 

Your local WebHR Administrator is the primary point of contact for any questions or issues regarding the 
WebHR application.  
However, you can send questions/comments to the WebHR Help Desk, using the Contact Us option. 

1. Enter your comment/question into the text box. 
Please fill out the form below to contact us! 
Your comment will be routed to the HTM Helpdesk for processing. 

2. Click the Submit Item button. 
You should receive a response to your comment/question by the next business day.  

 

WebHR HR Edition page>Help>Contact Us 

Note: When using Contact Us, you cannot attach and send graphics and/or screen 
captures to the WebHR Help Desk. 
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Log Off Menu 
Click the Log Off menu.  

 

WebHR HR Edition>Log Off 

WebHR returns to the I Acknowledge Warning page. 

 

WebHR I Acknowledge Warning page 
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Working on a Request for a Personnel Action 

Initiating an SF-52 for Recruitment 

Requests>New Request 

The user uses the New Request option to create a recruitment action. There is no data automatically 
pulled into the New Request Form (Gain) from the PAID system, because no employee is linked to a 
recruitment action.  

Note: Any action created in the HR Edition is only visible to HR and not the service 
lines. 

1. Open the Requests menu. 

2. Click the New Request option.  
The Action Types list box displays with an alphabetical list of all actions for a request.  

 

Requests-Submissions page 

Note: The request submission pages that display vary depending on the type of action 
you initiate. 

3. Select a Recruitment action type. 
Requests-New Request Form (Gain) page displays. 
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New Request Form (Gain) (for  Recruitment) page 

4. Review the Requests-New Request Form (Gain) page.  
Verify the information. 

5. Pro Effective Date is a required field.  
Manually enter a date or select a date from a pop-up calendar. 

• For today’s date, click Today at the bottom of the calendar. 

• Click the date box and select a date from the calendar. 

• Type in a date with the format: mm/dd/yyyy.  

 

Pop-up Calendar  

6. Optional: Update/change the name(s) in the Action Requested By and Action Authorized By sections. 
Action Requested By and Action Authorized By are auto-populated, only in the HR Edition, with 
the name of the station HRO.  

• If this information is changed to a person outside of HR, the action is not visible. 

• Once the action is submitted, the Requested By and Authorized By fields cannot be edited. 

7. Change/update the contact information, if necessary. 
The Contact information defaults to the user who is logged on and initiating the SF-52; however, the 
user can change this information. 
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8. Ensure the correct site is selected in Part B Position Data. 
The Part B To and Part B Position Data sections are auto-populated. For a table of Part B To and Part 
B Position Data fields, refer to page 19. 

9. Click the Submit Request button. 
Information pop-up displays. 

 

Proceed with Request Submission pop-up 

10. Click the OK button. 
If the Pro Effective Date and Work Schedule hours are not complete, the page redisplays. 

Note: A red asterisk and Required Field (*Required Field) displays to the right of the 
text boxes for fields that are mandatory, but incomplete. If the mandatory fields are 
not completed, the SF-52 will not move forward. 

11. Add the mandatory information and click the Submit Request button again. 
Information pop-up displays. 

12. Click the OK button again. 
The Submission complete page displays. 

 

Requests-New Request Form (Gain)>Submission Complete page 

13. Use the options to view request details, edit the request, view the SF-52, and submit a new request. 

a. Click the magnifying glass icon  to view request details. 

b. Click the pencil icon  to edit the request. 

c. Click the 52 icon  to view the completed SF-52. 
An example of a completed SF-52 is on page 140. 

d. Click the green/yellow icon  to submit a new request. 
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Initiating an Action for an On-board Employee 

Requests>New Request 

Use the New Request option to create an action for an on-board employee, such as a Promotion.  

1. Open the Requests menu.  

2. Click the New Request option.  
The Action Types list displays all the available actions alphabetically.  

 

Requests>New Request>Requests-Submission (Promotion) page 

3. Select a Promotion action type. 
An Employee list displays when you select an action type that affects an on-board employee, such as 
a promotion. 

 

Requests-Submission-Employee page 

Note: The request submission pages that display vary depending on the type of action 
you initiate. 

4. Type one or more letters in the Last Name box and click the calendar with binoculars icon .  
All employees with the entered last name display; there may be one or many.  
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Requests-Submission>Employee list page 

Note: Only employees at the assigned station display. 
Only data from the local station displays, unless the action is at the VISN level or 
higher.  

5. Locate the employee and click the green/yellow icon  next to the name.  
An SF-52 template (Request-Submission-Employee) displays with the Part B, Part B From, and Part 
B Employee Data sections auto-populated with current data from PAID. 

 

Request-Submission-Employee-Action (Promotion) page 
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6. Optional: Update/change the name(s) in the Requested by and Authorized by sections. Requested By 
and Authorized By are auto-populated, only in the HR Edition, with the name of the station HRO. 

• If this information is changed by a person outside of HR, the action is not visible. 

• Once the action is submitted, the Requested By and Authorized By fields cannot be edited. 

7. Change/update the contact information, if necessary. 
The Contact information defaults to the user who is logged on and initiating the SF-52; however, the 
user can change this information. 

8. Pro Effect Date is a required field. 
Manually enter a date or select a date from a pop-up calendar. 

• For today’s date, click Today at the bottom of the calendar. 

• Click the date box and select a date from the calendar. 

• Type in a date with the format: mm/dd/yyyy.  

 

Pop-up Calendar  

9. Ensure the correct site is selected in Part B Position Data. 
The Part B, Part B From, and Part B Employee Data sections are auto-populated. For a table of Part B 
To and Part B Position Data fields, refer to page 68. 

10. Click the Submit Request button. 
Information pop-up displays. 

 

Proceed with Request Submission pop-up 



 

October 2011 WebHR C3-C1 Conversion Project 97 
 User Manual for the Automated HR Edition (WEBH*) 

11. Click the OK button. 
If the Pro Effect Date is not complete, the page redisplays. 

Note: A red asterisk and Required Field (*Required Field) displays to the right of the 
text boxes for fields that are mandatory, but incomplete. If the mandatory fields are 
not completed, the SF-52 will not move forward. 

12. Add the mandatory information and click the Submit Request button again. 
Information pop-up displays. 

13. Click the OK button again. 
Request Details page displays 

Note: The action is automatically assigned a (request) ID number, a status of Pending, 
and is saved into WebHR. It is now ready to be approved and moved to HR. 

 

Requests-Details page 

To complete the submission of an SF-52 from PAID-Employees Details, refer to Request –Details on 
page 24. 
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Editing an SF-52 Request 

Staffing>Vacancies 

You can correct or edit an SF-52 from the Requests Editing page. Use the Requests-Editing page to 
add/change information in Parts A, B, C, D, E, F, and Attachments. 

1. From the Staffing page under Options, click the pencil icon  to edit the selected request (action). 
The Requests-Editing page displays. 

2. Click the magnifying icon  to view the Requests-Details page. 

3. Click the 52 icon  to view the SF-52 in official format. 
An example of a completed SF-52 is on page 140. 

4. Click the paperclip icon  to view the Attachments page. 

 

Staffing>Vacancies>Requests-Editing page 
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Part A (Request Info) 

Action Requested By and Action Authorized By are both unavailable, because once the SF-52 is 
submitted, you cannot change the requested and authorized sections. 

SF-52 Part A-Requesting Office 

 

SF-52 Par t A-Requesting Office 

1. The Requests Editing page opens with Part A displayed, but if necessary, click Part A to the right of 
icons to display the Request Info page. 

Note: After each edit, you must click one of the Submit button(s) or the 
changes/corrections will not be saved. 

 

Requests Editing-Par t A/Request Info page 

2. In the Contact Information section, change/correct the name and phone, if necessary. 

3. Click the Submit Contact Information option. 
Confirmation displays that the contact information is saved. 

 

Confirmation pop-up: Contact Information was saved 
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4. In the Request Type section, modify the action type, if necessary. 

5. Click the Submit Request Type Change button.  
Confirmation displays that the request type is saved. 
New action type displays as the Current Type in the Request Type section. 

 

Confirmation pop-up: Request Type was saved 

6. In the Proposed Effective Date section, modify the date (Current Value), if necessary. 
Manually enter a date or select a date from a pop-up calendar. 

• For today’s date, click Today at the bottom of the calendar. 

• Click the date box and select a date from the calendar. 

• Type in a date with the format: mm/dd/yyyy.  

 

Pop-up Calendar  

7. Click the Submit Proposed Effective Date button. 
Confirmation displays that the proposed effective date is saved. 
New date displays as Current Value on the Request Info page. 

 

Confirmation pop-up: Proposed Effective date was saved 

 



 

October 2011 WebHR C3-C1 Conversion Project 101 
 User Manual for the Automated HR Edition (WEBH*) 

8. Click the Submit Effective Date button. 
Confirmation displays that the proposed effective date is saved. 
New date displays as Current Value on the Request Info page. 

 

Confirmation pop-up: Effective date was saved 

Note: After editing, you must click the Submit button(s) or the changes/corrections will 
not be saved. 

Part B 

All sections of the Part B pages can be modified. Part B includes: NOALA, From, To, Employee Data, 
Position Data, and New Employee. 

SF-52 Part B-For Preparation of SF-50 

 

SF-52 Par t B-For  Preparation of SF-50 
Fir st Action/Second Action/Employee Data/Position Data 
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Part B – NOALA 

SF-52 Part B First Action and Second Action (NOALA) 

 

SF-52 Par t B Fir st Action and Second Action (NOALA) 

1. Click Part B to the right of icons. 

2. Select NOALA. 
Part B-NOALA page displays. 

 

Requests-Editing-Par t B – NOALA 

3. In First Action, add/change the information. 

4. Click the Save First Action button. 
Confirmation displays that the first action is saved. 

 

Confirmation pop-up: Fir st Action was saved 
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5. In Second Action, add/change the information. 

6. Click the Save Second Action button. 
Confirmation displays that the second action is saved. 

 

Confirmation pop-up: Second Action was saved 

Part B – From 

SF-52 Part B From: Position Title and Number 

 

SF-52 Par t B From: Position Title and Number  

1. Click Part B to the right of icons. 

2. Select From. 
Part B-From page displays. 
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Requests-Editing-Par t B – From 

3. In From: Position Title and Number, add/change the information. 

4. Click the Submit Part B From button. 
Confirmation displays that Part B From is saved. 

 

Confirmation pop-up: Par t B From was saved 

Part B – To 

SF-52  Part B To: Position Title and Number 

 

SF-52 Par t B To: Position Title and Number  
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1. Click Part B to the right of icons. 

2. Select To. 
Part B-To page displays. 

 

Requests-Editing-Par t B-To 

3. In To: Position Title and Number, add/change the information. 

4. Click the Submit Part B To button. 
Confirmation displays that Part B To is saved. 

 

Confirmation pop-up: Par t B To was saved 

Part B – Employee Data 

SF-52 Part B Employee Data 

 

SF-52 Par t B Employee Data 

1. Click Part B to the right of icons. 

2. Select Employee Data. 
Part B-Employee Data page displays. 
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Requests-Editing-Par t B – Employee Data 

3. In Employee Data, add/change the information. 
Service Comp Date is a required field. 

4. Click the Submit Employee Data button. 
Confirmation displays that Employee Data is saved. 

 

Confirmation pop-up: Employee Data was saved 

Part B - Position Data 

SF-52  Part B Position Data 

 

SF-52  Par t B Position Data 

1. Click Part B to the right of icons. 

2. Select Position Data. 
Part B-Position Data page displays. 
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Par t B – Position Data 

3. In Position Data, add/change the information. 

4. Click Submit Position Data. 
Confirmation displays that Position Data is saved. 

 

Confirmation pop-up: Position Data was saved 

Part B – New Employee 

SF-52 Part B-New Employee 

 

SF-52 Par t B-New Employee 

1. Click Part B to the right of icons. 

2. Select New Employee. 
Part B-New Employee page displays. 

Shield with an exclamation point icon  When updating information on this page, you should try 
and re-import the employee’s information from PAID. 
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Requests-Editing-Par t B – New Employee 

3. In New Employee, add/change the information. 

4. Click the Submit New Employee button.  
Confirmation pop-up displays 

 

You are about to update new employee information, Proceed? pop-up 

5. Click the OK button. 
Confirmation displays that Employee Data is saved. 

 

Confirmation pop-up: New employee information edited successfully 
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Part C – Reviews and Approvals 

SF-52 Part C Reviews and Approvals 

 

SF-52 Par t C Reviews and Approvals 

1. Click Part C to the right of icons. 
Part C-Reviews and Approvals page displays. 

 

Requests-Editing-Par t C – Reviews and Approvals 

2. In Reviews and Approvals, sign/approve the information. 

3. Click each signed document icon  to electronically certify and date your signature for sections 1 
and 2. 
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4. Click the OK button. 
When the information is certified and dated, the padlock icon  replaces the signed document icon 

. 

 

I cer tify that the information entered on this form is accurate and that the proposed action is in compliance 
with statutory and regulatory requirements pop-up  

Part D – Remarks by Requesting Office 

SF-52 Part D Remarks by Requesting Office 

 

SF-52 Par t D Remarks by Requesting Office 

1. Click Part D to the right of icons. 
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2. Click Part D. 
Part D-Remarks by Requester page displays. 

 

Requests-Editing-Par t D – Remarks by Requesting Office 

Note that displays on Part D-Remarks by Requesting Office: 
Note to Supervisors: Do you know of additional or conflicting reasons for the 
employee‘s resignation/retirement? 
(If Yes, please state these facts on a separate sheet and attach to SF-52.) 

3. In Remarks by Requester, the requesting office can add comments. 

4. Click the Submit Part D button.  
Confirmation displays that Part D is saved. 

 

Confirmation pop-up: Par t D was saved 
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Part E – Employee Resignation/Retirement 

SF-52 Part E Employee Resignation/Retirement 

 

SF-52 Par t E Employee Resignation/Retirement 

1. Click Part E to the right of icons. 
Part E-Employee Resignation/Retirement page displays. 

 

Requests-Editing-Par t E – Employee Resignation/Retirement 

2. In Employee Resignation/Retirement, the employee comments pertaining to resignation/retirement 
can be added. 

3. Click the Submit Part E button. 
Confirmation displays that Part E is saved. 

 

Confirmation pop-up: Par t E was saved 
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Part F – Remarks for SF-50 

SF-52 Part F Remarks for SF-50 

 

SF-52 Par t F Remarks for  SF-50 

1. Click Part F to the right of icons. 
Part F-Remarks for SF-50 page displays. 

 

Requests-Editing-Par t F – Remarks for  SF 50 

2. In Remarks for SF-50, add comments pertaining to the form, Notification of Personnel Action (SF-
50). 

3. Click the Submit Part F button. 
Confirmation displays that Part F is saved. 

 

Confirmation pop-up: Par t F was saved 
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Attachments 

 

Requests-Editing-Attachments page 

1. Click Attachments to the right of icons. 
Attachments page displays. 

2. Add the information for pertinent forms. 
Title and Browse are required fields. 

3. Click the Upload Attachments button. 
Confirmation displays that the document is uploaded. 

 

Confirmation pop-up: Document was uploaded 
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Attachments Page 

Field Description 
Upload Form 
Title Type in the title of the document 

Mandatory  
Type Select the type of document from the Type drop-down list 

• Memorandum 
• Position Description 
• Job Analysis/KSAO Information 
• Functional Statement 
• Compensation Panel Action 
• Board Action 
• Application 
• Letter 
• Checklist 
• OF-8 
• Form 
• Other 

Description Type a brief description of the document 
Optional 

Attachment Click the Browse button to locate the document (mandatory) 
Double click the selected document and click the Upload 
Attachment button. 
Attachments are saved/submitted to the SF-52 and display in 
the Associated Attachments section. 

Associated Attachments 

 
Click the document (file) icon to open the selected document 

 Click the X in the red circle icon to delete an attachment 

ID Number assigned to the SF-52 
Document Name of the document 
Type Type of the document 
Status Status of the document 
Description Description of the document 
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Submitting an SF-52 

Requests>New Request 

Submit an SF-52 from a Request Submission page. 

Note: The pages that display vary depending on the type of action you initiate. 

 

Requests-New Request Form (Gain) (Recruitment) page 

1. Verify the Action Requested. 
Select a more specific action type from the Action Requested drop-down list, if necessary.  

2. Pro Effective Date is a required field. 
Manually enter a date or select a date from a pop-up calendar. 

• For today’s date, click Today at the bottom of the calendar. 

• Click the date box and select a date from the calendar. 

• Type in a date with the format: mm/dd/yyyy.  

 

Pop-up Calendar  
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3. Verify the Requester.  

• The requester defaults to the station HR Officer, but you can edit the name, title, and date. 

• Name and Title are mandatory. 

4. Verify the Authorizer.   

• The authorizer defaults to the station HR Officer. 

• Do not edit the authorizer name and title. 

Notes: 

• If this information is changed to a person outside of HR, the action is not visible. 

• Once the action is submitted, the Requested By and Authorized By fields cannot be edited. 

5. Verify the name/phone; modify if necessary. 

6. Add/change information, where necessary. 

7. Enter the number of hours into the box to the right of Work Schedule; it is a required field. 

Note: Full-time is 80 hours per pay period. 

8. Click the Submit Request button. 
Information pop-up displays. 

 

Proceed with Request Submission pop-up 

9. Click the OK button. 
If the confirmation page does not display, review the Request Submission page for any missing data.  

Note: A red asterisk and Required Field (*Required Field) displays to the right of the 
text boxes for fields that are mandatory, but incomplete. If the mandatory fields are 
not completed, the SF-52 will not be saved. 

10. Complete the fields marked with a red asterisk and Required Field (*Required Field). 

11. Click the Submit Request button again. 

12. Click the OK button. 
Submission complete page displays. 
The Request has been successfully submitted 
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Submission Complete page 

13. Use the Submission Complete page to view the request, edit the request, view the SF-52, or submit a 
new request. 

a. Click the magnifying glass icon  to view request details.  

b. Click the pencil icon  to edit the request. 

c. Click the 52 icon  to view the completed SF-52. 
An example of a completed SF-52 is on page 140 

d. Click the green/yellow icon  to submit a new request. 
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Processing an Approved SF-52 
The View All Requests option under the Requests menu provides a list of all the SF-52s currently in 
process or waiting for approval from a customer or an HR staff member.  

• When an SF-52 is created in the Customer Edition or the HR Edition, it automatically generates an 
entry in the log of View All Requests.  

• The log of View All Requests contains basic information, such as the action ID, type of action, status, 
requested by, days since approved, organization, employee, specialist, proposed effective date, and 
effective date. 

 

Requests>View All Requests>Requests page 

Use the Options to display action details, edit the action, display the SF-52 as a form, or attach supporting 
documentation.  

1. Click the magnifying glass icon  to view request details.  

2. Click the pencil icon  to edit the request.  

3. Click the 52 icon  to view the completed SF-52. 
An example of a completed SF-52 is on page 140. 

4. Click the paperclip icon  to view supporting documentation previously attached. 
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Printing the SF-52 

IE Browser 

You cannot print from WebHR, but you can print the SF-52 from your Browser. Printing is not required. 
All actions remain in WebHR for three years.  

Note: Resignation and separation SF-52s must be kept on file in the Official Personnel 
Folder/Electronic Official Personnel Folder (OPF/E-OPF). To place an SF-52 in 
the OPF or E-OPF, you need to print the SF-52. 

To configure the Browser to print SF-52s properly:  

1. On the Browser, open the File menu. 

2. Select Print Preview. 

 

Browser  File menu with Pr int Preview selected 

 

Browser  File menu with Pr int Preview>1 Page View 

3. On the Print Preview Toolbar, select 3 Page View.   

 

Browser  File menu with Pr int Preview>3 Page View 
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4. Click the MS Browser Print Preview icon  or use Alt U to open Page Setup.  

 

Browser  File menu>Pr int Preview>Page Setup 

5. On Page Setup: 

a. Remove the text that displays in the Header and Footer boxes. 

b. In the Margins section, change the four margins, Left, Right, Top, and Bottom to 0. 

• The zeroes do not stay; but entering 0 forces the margins to default to the smallest possible 
margins.  

• Your print preview should display only two pages instead of three pages. 
If these modifications do not work, select 95% from the Shrink to Fit drop-down list and 
only two pages should display. 

 

Browser  File menu>Pr int Preview> 

• If you are using OPFs, the printer is capable of two-sided printing. Print the SF-52 two-sided.  

• If the printer is not capable of two-sided printing, print two pages or print one page and manually 
print the second page on the reverse side of the printed page. 

• If you are scanning for an E-OPF, print two pages.  

• If actions are mailed for scanning by the contractor, use a single page document and save as a .pdf. 

• If the Processing and Records staff do not have dual monitors or split screens, the staff prints the SF-
52 to code into PAID. 
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Clipping Attachments to the SF-52 

Requests>View All Requests 

You can attach documents to SF-52s from the Customer Edition and the HR Edition of WebHR.  

Under the Request-Details heading, a paperclip icon  displays indicating that document(s) are attached 
to an SF-52. 

 

No attachments to the SF-52 

 

Attachments to the SF-52 

In WebHR, you can view and clip attachments to an SF-52 when a paperclip icon  displays. 

1. On the Requests-Details page, click the paperclip icon  to view the uploaded/attached documents. 
Attachments page displays. 

or 

2. On the Request Details page, click the document (file) icon Attachments, to clip documents to the 
SF-52. 
The Attachments page displays. 

3. Click the Upload Attachment button. 
Confirmation displays that the document is uploaded. 
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ARPA Request Editing 

• On the Attachments page, the columns can be sorted. For more information, refer to page 137. 
• When uploading several documents with the same title, enter a description for each. 
• If your attachment type is not in the list, select other or memorandum and indicate the actual 

document type in the description 
• Standard attachments allowed include Windows based files, to include file formats with .doc, .xls, 

.pdf, etc., extensions. 
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Troubleshooting 

Update User Profile 

Update user profile 
On the user profile page, the title and/or phone number are not correct. How do we update this 
information? 
This information comes directly from Outlook; the database is referred to as Active Directory.  
• If the title and phone number are correct in Outlook, but not in WebHR, send an email to the 

WebHR Help Desk, advising of the change. The WebHR user account will be updated.  
• If the information is incorrect in Outlook, contact the local IT staff to make corrections. After the 

change is made, notify the WebHR Help Desk. 

Cannot Access the Application 

User cannot access the application 
User receives System Error message and does not see the I acknowledge page 
A number of things can cause this. 
Check a few things before contacting the WebHR Help Desk. 

1. Does the user have the appropriate Agent Type and Role Assignment? 
Refer to User Assignments in WebHR on page 5 of the User Manual for the Administrator Role. 

2. Is the user accessing the correct edition of the application?  
Only HR personnel should access the Automated Human Resources Edition of the application. All 
other users should use the Customer Edition. 

3. Is the user new?  

a. Check the Browser settings--make sure all three Use items are selected. 
• Use SSL 2.0 
• Use SSL 3.0 
• Use TLS 1.0 

b. To check the Use items: 

i. Open the Browser on the user’s computer. 

ii. Click Tools and select Internet Options. 

iii. Select the Advanced tab and scroll down to the bottom of the list. 

iv. Make sure all three Use check boxes are selected. 

v. Click OK.  

Note: If the user still cannot access the application, the local WebHR Administrator 
should contact the WebHR Help Desk. 
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Cannot View the SF-52 to Approve 

Approver and/or requester cannot see the SF-52 to approve 
Review the organizational hierarchy. 
Is the service line of the preparer at the same level or below the requester and/or approver?   
A requester and/or approver can be higher in the chain of command in the organization than the 
preparer, but not below. 

Cannot Find Appropriate Employee 

Preparer cannot find the appropriate employee on which to initiate an action 
Review the organizational hierarchy. 

1. What is the cost center/org code for the employee?   
Check the cost center/org code for the employee in VISTA/PAID. 

2. What is the cost center/org code for the preparer?  
The cost center/org code for the preparer may be different than the VISTA/PAID cost center. 

3. Is the cost center/org code service line of the employee, mapped to the organizational hierarchy?   
If not, contact the WebHR Help Desk to add the service line. 

4. Does the preparer have access to the cost center/org code for the identified employee?  
If the preparer does not have access to the cost center/org code identified, several options are 
available: 

• A different preparer may need to initiate the action 
• Realign the service line 
• Move the preparer 
• Contact the WebHR Help Desk 
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Error Management 

 

Er ror  Management-User  Assistance message 

Error Management Message 

The system has detected an error. 
This error has been logged, and a message sent to the administrator of this web 
application. 
We apologize for this inconvenience. 
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Session Expiring 

Warning Message: session expiring/expired 
WebHR has default time set for how long the application remains open without activity. When the 
default time is reached, the Expiring/Expired notifications display. 

 

Example of the Expir ing notification 
Your  session will expire in 60 seconds! 

 

Example of the Expired notification 
Your  session has expired 
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Glossary 
Term Definition 

508 Compliance A Public Law that agencies must provide employees and members of 
the public who have disabilities (e.g. vision impairment) access to 
electronic and information technology that is comparable to the access 
available to employees and members of the public who are not 
individuals with disabilities. 

Action Type  Action type is the name of the action a preparer selects to identify the 
action HR is to process, e.g., Promotion, Recruit, Transfer, etc. These 
actions are sorted as categories in the background, in order to auto-
populate the SF-52. 

AdjBasicPay Adjusted Basic Pay 
Agent Type Assignment Agent type assignment is the level of access granted to an authorized 

user of WebHR.   
Agent type assignments are done in the background system by the 
HTM HRIS staff as the first step in permitting users to access the 
application.  
Agent type assignment works in conjunction with Role assignment 
within the application.  
The agent types for the Customer Edition are: Delegate, Manager 
Assistant, Manager and for the HR Edition are: Staff_HR and HRO. 
Each of these types dictates what edition of the application a user can 
access, as well as what a user can do within the application when the 
agent type is paired with a role assignment. 

Annuitant Annuitant is a federal retiree 
AnnuitantCode Annuitant code indicates a re-employed annuitant who is presently 

receiving retirement benefits.   
Appointment Appointment is the method by which employees are placed in their 

positions. 
Appropriation Code Appropriation code is a combination of a 4-digit organizational code 

and a 4-digit cost center code, which identifies a specific reference for 
costing and tracking programs. 

Approver/Manager  Approver (Role) is a service chief (manager) or someone who has 
authority to sign/approve the SF-52. This person can be higher in the 
chain of command from the preparer’s service line.   

Approving Official Approving Official is an individual with authority to initiate and/or 
sign off on SF-52s. This individual also has access to reports that are 
identified as manager specific. There should be at least two approving 
officials per service/section. 

ARPA Automated Request for Personnel Action 
BasicPay On the SF-52, basic pay is the amount in the general pay tables for the 

grades or established for T38 positions. 
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Term Definition 

Bus Code BusCode is the Bargaining Unit Status (BUS) code of the employee’s 
position with regard to federal employee bargaining unit 
representation.  
BUS code 8888 is for employees who are ineligible for bargaining unit 
representation, e.g., supervisors, managers, human resources specialist, 
etc.   
BUS code 8888 is not appropriate for employees in pay plans 1, 2, 4, 
5, 6 or G.   
BUS code 7777 is for employees who are not excluded by law, but are 
excluded due to negotiations.   
Covered employees have codes specific to the location and the selected 
unions.    
For appropriate four-digit BUS codes, refer to the table in MP-6, Part 
V Chapter 6, Supp. No. 1.5, July 11, 2008 HRIS Bulletin 08-16.   
Consolidated in the BUS codes table: is used for any bargaining unit 
employee who is represented by AFGE, NFFE, NAGE, ANA or SEIU; 
use the appropriate consolidated BUS code P= Professional or NP= 
Non Professional. 

Category Category is a grouping of similar types of actions.   
Gains pick all recruitments, appointments, transfers, etc., any action 
that causes the organization to gain staff.   
Losses pull all separations, terminations, resignations, retirements, etc., 
any action that causes the organization to lose staff. 
Employee pulls any actions created with an employee’s name. 

CC Code Cost Center Code 
Centurion Centurion is the system used to initialize authorization for user access; 

it is a behind-the-scenes application used in the Healthcare Talent 
Management (HTM) office. The HTM office manages Centurion and 
the WebHR HRIS Team makes changes to it.  

Class 1 (C1) Class 1 software includes applications and Commercial Off the Shelf 
(COTS) product interfaces installed on or interacting with VA 
computing environments. Class 1 products are created by or evaluated 
and certified by Product Development (PD) to comply with VA 
established criteria.   
Class 1 products are distributed for use at the enterprise level and PD is 
responsible for providing or arranging for the provision of customer 
support (Tier II) and maintenance (Tier III) support. 

Class 3 (C3) Class 3 software is also referred to as Field Developed Software 
(FDS). Class 3 products may originate from any unrelated PD source, 
including field developers, non-IT VA staff (e.g., physicians), vendors, 
open source, research, or educational organizations. Class 3 products 
generally have a limited and non-standardized distribution across VA 
systems and are not automatically covered by Office of Information 
and Technology (OIT) Tier II and III support commitments. 
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Term Definition 

Competitive Level Competitive level identifies positions in a competitive area that are in 
the same grade or occupational level; the levels are so similar that the 
agency may readily assign employees from one position to another 
during a reduction in force (RIF). 

Cost Center Cost center is a 4-digit numerical code that identifies the service line 
for fiscal accountability and reporting. 

Costed Costed is the funding for the authorization to be charged or costed 
against an appropriation code. 

Customer Customer refers to the users of the WebHR Customer Edition 
application. 

Delegate/Preparer Delegate (Agent) in the WebHR application, is a staff member 
responsible for the initial entry of a Request for Personnel Action (SF-
52). This staff member can track the status, send messages to HR, and 
view the employee information on the SF-52. 

Duty Code Duty code identifies an employee's work site (duty station) when 
assigned at a location other than the parent station. 
Only applicable to facilities with consolidated HR offices. 

Duty Code Flag Specific to Centurion/WebHR  
Duty code flag is an indicator that the organization is part of a 
consolidated group sharing the same station number, but separated into 
hospitals and then sub-organizations within the hospitals.  
Only applicable to facilities with consolidated HR offices. 
The separation of sites in Centurion/WebHR is based on a station 
number. When the station number is shared, Centurion/WebHR must 
find the differentiation for hospitals and then for each of the hospitals, 
including any additional duty station codes that indicate the sub-
organizations. The duty station codes within the hospitals are 
automatically pulled for non-consolidated VISNs where the station 
number differs for each hospital. 

ECF Executive Career Field 
E-Classification 
(E-Class) 

E-Classification is an automated application that uses artificial 
intelligence to assign the classification (PP, Series, Grade) to positions 
using information put in by users and following the OPM Position 
Classification Standards. 

E-OPF Electronic Official Personnel Folder 
Encumbered Encumbered, in the HR community, describes a filled position 
EOD Entrance on Duty 

In a current assignment at the VA, entrance on duty is the date an 
employee starts working.  
Changes in EOD occur when an employee begins working at a VA, 
moves to a new VA site, or returns to VA from other employment, 
either Federal or civilian. 
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Term Definition 

Existing to Existing Action 
Types 

Examples of Existing to Existing (E to E) action types are: promotion, 
change to lower grade, or change in position. These action types are 
generally restricted to current employees in the roles of a specific 
organization.  
E to E action types require all appropriate data fields to be filled in for 
both To and From, as well as employee data and position data. 

Existing to Non-Existing 
Action Types 

Examples of Existing to Non-Existing (E to NE) action types are: 
resignation and termination (separation actions). These action types 
remove employees from their existing organization. 
E to NE action types require the data fields to be filled in for From, as 
well as employee data and position data. To is left blank for separation 
actions.  
In WebHR, HRIS builds new codes for E to NE action types. 

Fegli Federal Employees Group Life Insurance 
Fegli Code Federal Employees Group Life Insurance code indicates the extent of 

life insurance coverage or non-coverage provided/selected.  
The codes range from A0 (ineligible) to Z5 (basic plus additional 
option with 5 times pay, standard option and family option with 5 
times multiple).  
For the entire list of codes, refer to the Office of Personnel 
Management, Operating Manual, Guide to Data Standards, Part A 
Human Resources, pages A-131 through A-135. 

Fiscal Employee A fiscal employee is an employee in the financial or business office at 
a site. 
At some locations, fiscal employees are required to review various 
action types and are granted access to the HR Edition for review of SF-
52s. 

FY Fiscal Year 
Grade  Grade is the specific identifier that indicates pay level within a pay 

plan system. An employee's base pay range is determined by the grade 
code. Ungraded positions are coded 00. 

HR Human Resources 
HR Dashboard HR Dashboard is a web link to VHA Support Service Center (VSSC) 

reports, which provides an overview of human resource and workforce 
management key indicators in categories such as, workforce 
demographics, compensation and benefits, service and quality, etc. 

HR Library HR Library is a web link to the Office of Human Resources 
Management Intranet with information on HR policies on Benefits, 
Pay Administration, Recruitment and Staffing, etc. 

HRIS Human Resources (Information Systems) 
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Term Definition 

HRIS Specialist Human resources information systems specialists do work that 
involves developing, delivering, managing, and maintaining HR 
information systems when the paramount knowledge requirement is 
human resources management, rather than information technology. 

HRO Human Resources Officer 
Each site allows only one site human resources officer per VAMC. 

HRRC Human Resources Resource Center 
HTM Healthcare Talent Management office 
Local Adj Locality Pay Adjustment 

Local adjustment is the pay amounts established as supplemental pay, 
based on higher cost of living assessments in some geographical areas. 

LOCPAY Locality Pay  
Locality pay is an authorized percentage of base pay for employees in 
a duty station designated as a locality pay area. The amount is included 
in the payable salary. 

LWOP Leave Without Pay 
Manager/Approver Manager (Agent) is a service chief (manager) or someone who has 

authority to sign/approve the SF-52. This person can be higher in the 
chain of command from the preparer’s service line. 

Manager_Assistant/Requester Manager_Assistant (Agent) is a person who can request (recommend) 
an action for an employee assigned to the requester’s program area, but 
not approve the action. 

NOAC Nature of Action Code   
Nature of action code indicates the type of personnel action being 
processed; it identifies the appropriate code and description for 
printing the NOA of the SF 50-B and the retirement record, as well as 
provides statistical data for reporting purposes.   
For NOAs used by VA, refer to Appendix D at 
http://vaww.va.gov/wist/PAIDcodingDocs/NOAappd.doc 

Non-Existing to Existing 
Action Types 

Examples of Non-Existing to Existing (NE to E) action types are: 
recruitment actions and appointment actions-any action that adds a 
new employee or an additional service. 
NE to E action types require the data fields to be filled in for To, as 
well as some position information in part B of the SF-52. 

Number Number is the same as Position Description (PD) Number: On Gain 
Request Submission 

OCC Occupation Series Code  
Occupational series code identifies the subdivision of an occupational 
family or group, under which an employee's position is classified. 

OHRM Office of Human Resources Management 
OPF Official Personnel Folder 
OPM Office of Personnel Management 

http://vaww.va.gov/wist/PAIDcodingDocs/NOAappd.doc�
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Term Definition 

Organizational Code Organizational code is a 4-digit numerical code that identifies a service 
line; the grouping defines a responsibility or class of programs. 

P31 P31 is a report that lists all the employees in the user’s service. This is 
the one report that displays name, title, series, PD number, grade, step 
and salary, as well as service computation date, etc. 

PAID Personnel and Accounting Integrated Data 
PAID is the package that supports employee master record data 
maintained by local Human Resources and Fiscal offices. 

PAIDID PAIDID is a unique identifier (number) assigned to each employee 
when added to PAID. 

Pay Basis Pay basis identifies the principal condition that serves as a basis for 
computing pay, e.g., hourly, per annum, in terms of time, production or 
other criteria. 

Pay Plan Pay plan identifies the pay system under which the employee’s 
compensation is determined, e.g., GS, WG, etc. 

PD Position Description 
PED Proposed Effective Date 

Proposed effective date defaults to three months from the date the SF-
52 is entered. The service chief submitting the SF-52, fills out the 
PED. 

POS Position 
PP Pay Plan 
Preparer/Delegate Preparer (Role) in the WebHR application, is a staff member 

responsible for the initial entry of a Request for Personnel Action (SF-
52). This staff member can track the status, send messages to HR, and 
view the employee information on the SF-52. 

QTU Qualifications Standards Used (the T is a typo on the form) 
Regraded Regraded is a change to a position’s classification, which affects the 

grade of the position. 
Request ID  Request ID is a control number assigned to SF-52 actions, which 

allows for the identification and tracking of the request.  
Currently, WebHR uses a global numbering system to automatically 
assign a number to any action submitted by a preparer. The numbers 
are sequential and do not indicate the location, organization, FY, etc. 
where the action was created. 

Requester/Manager_Assistant Requester (Role) is a person who can request (recommend) an action 
for an employee assigned to the requester’s program area, but not 
approve the action.  
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Term Definition 

Role Assignment Role assignment works in conjunction with the agent type assignment 
to allow a user to access and utilize the specific WebHR edition 
needed. Multiple roles can be assigned to a user depending on the 
authorized level of access.  
Roles that parallel the agent types for the Customer Edition are: 
preparer, requester, approver and for the HR Edition are: Specialist and 
HRO.   
Local WebHR Administrators assign roles after an agent type is 
assigned by the HTM HRIS staff. These roles are based on the level of 
access a user should have in relation to work assignments. 

Role Type Assignment Role type assignment is the type of role assigned. There are customer-
type roles and HR-type roles. 

SAC Special Agency Check 
Series Series is the same as Occupation Series Code (Occ Code). 
Service Line Service line is the organization of a specific clinical focus (i.e., 

primary care, mental health, and geriatrics/extended care) led by a 
manager at the VA facility level.   

SF-50 Standard Form-50 
SF-52 Standard Form-52 
Specialist In the HR Edition, Specialist is the role type that parallels the 

Staff_HR agent type. 
Staff_HR Staff_HR includes the HR specialists and HR assistants assigned to 

Human Resources. In the HR Edition, Staff_HR is the agent type that 
parallels the Specialist role type. 

Standard Form (SF) 50 OPM Standard Form 50 – Notification of Personnel Action 
Standard Form (SF) 52 OPM Standard Form 52 – Request for Personnel Action 

Operating officials and supervisors use the form to request personnel 
actions and to secure internal agency clearance of requests for 
personnel actions. 
Employees use the form to request leave without pay, to change a 
name, or to notify the agency of intent to resign or retire. 

Status Within WebHR requests listing, status indicates the stage in which the 
SF-52 is. Based on the assigned status level, statuses are waiting, 
active, or no longer active 

Status Types Within WebHR, status types are pending, approved, terminated, 
completed, and suspended. 

Supvl Supervisory Level  
Supervisory level identifies the category of a supervisor’s 
responsibility. Supervisory codes are assigned during the classification 
process and annotated in the position description. 
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Term Definition 

TypeOfApt Type of Appointment   
This code identifies the type of appointment (career conditional, 
career, etc.) under which an employee is serving. 
• indicates whether the appointment is in the competitive service, 

excepted service, or senior executive service (SES) 
• indicates whether the appointment is permanent or temporary 
• indicates the tenure group to which it applies 

USA Staffing USA Staffing is the link available from within the WebHR system for 
use by HR staff. 

VA Department of Veterans Affairs 
VETPREF  Veterans Preference 

This code identifies the category of entitlement to preference to which 
an employee is entitled in the federal service, based on active military 
service that terminated honorably.  
For a list of the Veterans Preference codes, refer to MP-6, Part v, Supp. 
No. 1.5, Chapter 6, June 29, 2006, WIST bulletin 60-19. 

VetPro VA's web-based credentialing system for all VHA licensed health care 
personnel 

VHA Veterans Health Administration  
WebHR is used only by VHA 

VHALWD Veterans Health Administration Leadership and Workforce 
Development 
VHALWD is an enterprise system that incorporates a multitude of 
software applications that support leadership and development 
programs, succession planning, workforce performance, and other HR 
functions. 

VICE VICE is the name of a previous employee for a vacant position. 
VistA Veterans Health Information System Technology Architecture 
VSSC VHA Support Service Center  

This service center feeds data to the HR Dashboard. 
WEBH WebHR namespace 
WebHR Administrator WebHR Administrator is a staff member working in HR at a 

facility/program office.  
Human Resources Officer (HRO) appoints the administrator to act as 
the primary point of contact for local administration of the WebHR 
application. 

WebHR Automated Human 
Resources Edition 

This edition of the WebHR human resources application automates HR 
activities, including processing and tracking various personnel actions 
and functions.  
This human resources edition operates in conjunction with the WebHR 
Customer edition. 
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Term Definition 

WebHR Customer Edition This edition of the WebHR customer application automates human 
resources activities, including initiation of personnel actions. 
This customer edition operates in conjunction with the WebHR 
Automated Human Resources edition. 

WebHR Help Desk Central point of contact for all WebHR related issues and questions for 
users of WebHR and is supported by HTM HRIS staff.  
vhahtmhrishelpDesk@va.gov. 

WebHR SharePoint Site Microsoft SharePoint website, available to all VA employees 
http://vhaokldevhpdm43/sites/HR%20Systems/default.aspx 
This site contains information relating to the WebHR application. 

WMCO Workforce Management and Consulting Office 
WorkSite Work site is the location at which the employee is physically located 

for employment. 
 
 

mailto:vhahtmhrishelpdesk@va.gov�
http://vhaokldevhpdm43/sites/HR%20Systems/default.aspx�
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Appendix 

Sort Columns 

Sorting Columns 

 

WebHR System>Positions>View 

As you move the mouse over a heading, if the heading changes color and a hand with a 
pointing finger displays, the column can be sorted. 
• Click a heading once and the data is sorted in alpha/numeric order.  
• Click the heading a second time and the data is sorted in reverse order. 

 

WebHR>Requests>View All Requests 

• Click a heading and an up arrow displays, indicating the column is sorted in 
ascending order. 

• Click the heading with the arrow and the down arrow displays, indicating the column 
is sorted in descending order. 

 

Additional Pages of Records 

Moving to Another Page of Records 

 

WebHR>Positions>View 

In many WebHR pages, a blue bar with (page) numbers displays at the bottom of the 
page. 
Click a number to move to that page of records. 
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WebHR Icons  

Icon  Description 

 
WebHR document (file) icon used to select a particular document 

 WebHR XL (Excel) icon used to select a particular XL spreadsheet 

 WebHR MS Word icon used to select a particular MS Word document 

 WebHR binoculars icon used to search for a particular element 

 WebHR magnifying glass icon used to view the details of actions 

 WebHR green triangle/orange circle icon used to initiate a request for action 

 WebHR binoculars with calendar icon used to search for a particular element 

 WebHR staffing icon used in the Staffing Module (Vacancy Tracking) to track a 
vacancy 

 WebHR pencil icon used to edit requests for action 

 WebHR 52 icon used to view completed SF-52s 

 WebHR head icon used to select an employee on which to initiate an SF-52 

 WebHR double down arrow icon used to close sections of the Staffing Module 

 WebHR double up arrow icon used to open sections of the Staffing Module 

 
WebHR paperclip icon used to attach supporting documentation to SF-52s 

 WebHR envelope icon used to select a manager to whom to send an alert 

 WebHR arrow in a green circle (pointing right) icon used to view actions for a 
particular organization, processing unit, and specialist 

 
WebHR person icon used to select a registered user to which to assign a role type 

 WebHR X in a red circle icon used to delete items 

 
WebHR document (file) icon used to select a particular document 

 WebHR document with a pen icon used to digitally sign requests for action 

 
WebHR lock icon used to indicate an item cannot be edited 

 WebHR padlock icon indicates the information is certified 

 Microsoft Browser Print Preview icon used to open Page Setup 

 WebHR shield with exclamation point used to identify important notes 
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Sample of an SF-52 – Request for Personnel Action 

 

Sample of an SF-52 
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Sample of a Completed SF-52 – Request for Personnel Action 

 

Sample of a completed SF-52 
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